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Introducing ProVision®  
ProVision® is Power Monitors’ Power Quality (PQ) data analysis software. Sophisticated tools and advanced 

communications greatly expand the ability to record, manage and analyze power quality data.  

The easy-to-use graphical user interface is designed to get both the novice and the advanced user up to speed 

quickly.  

ProVision will connect to local recorders using a USB cable, or remotely to Bluetooth® capable recorders, Wi-

Fi capable recorders, and to PMI recorders having cellular modems.  

ProVision is used on Microsoft Windows based computers.  

   
                 ProVision with an Eagle recorder connected   
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Installing ProVision®   
There is no cost or license fee for ProVision or the USB driver. 

To connect and download PMI recorders, you will need the USB driver installed for your PC or Laptop to 

recognize the recorders. 

Both ProVision and the USB driver can be downloaded from the PMI website: 

https://powermonitors.com/downloads (select software) 

Once downloaded, run the install Wizard to complete the installation. Take all the default settings and allow 

installation of the sub-USB drivers. 

Note that your computer Administrator may need to perform the installs of ProVision and the USB driver.   

  

Assistance 
Help is always available if you need additional assistance.   

The technical support team at PMI is widely considered to be the best in the industry.  

Contact us 24 hours a day, 7 days a week for live tech support by calling:  

(800) 296-4120 

There are also many helpful items and videos on the PMI Support webpage. 

https://powermonitors.com/support 

 

 

  

https://powermonitors.com/downloads
https://powermonitors.com/support
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Quick Start 
Now that you have received a new PMI recorder and downloaded the ProVision and USB software, 

let’s walk through the basic Provision recording steps. 

1) Connect the Recorder 

Open the Provision software by clicking on the Eagle-eye icon that was created on your desktop during the 

installation, then connect the supplied cable to your recorder and to a USB port on your PC. 

You will notice the recorder has a Status LED, and when connected to your PC, the LED will be a solid green 

to indicate it is powered up and communicating. 

 Note: If your recorder does not connect with a USB cable, see the chapter entitled ‘Working with Recorders’ 

before proceeding.  

Also note that some recorders have different LED patterns.   

 
                     When connected to the PC, your PMI recorder will show in the Devices Pane  
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2) Initialize the Recorder 

The next step is to initialize the recorder and choose what you want to record. 

Select the [Recorder] menu at the top of ProVision, then select [Initialize] 

Initialization settings may vary between recorders, some settings may be ‘grayed’ out and are not selectable. 

ProVision shows the settings for the connected recorder. 

             

There are several pages of Initialization choices, see all the settings explained later in this manual. The default 

circuit type is set to Wye and will record phase to neutral voltages. 

 

When all selections are completed, select [Finish] at the bottom of the Screen. 
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Answer [Yes] to the initialization message.  

The data file is stored in the recorder’s memory. After initialization the data can be downloaded again and 

again, until AC power is applied to the recorder and a new recording is started. 

        

Note: Initializing a recorder will start a new recording when power is applied to the recorder. If the recorder is 

not initialized and power is applied, the previous recorded data will be appended to.  

The recorder is ready to go. Disconnect the USB cable or for wireless connections select [Disconnect] from the 

Recorder menu. 

3) Set the recorder 

Place the recorder at the site. See the recorder’s manual on how to hook up the specific recorder. Circuit 

Hookup Diagrams are found later in this manual. Remember to look at the Status LED before leaving the site. 

If the LED is not blinking, you are not recording. 

4) Download the Recording 

When you are finished recording at the site, it is time to download the data. For safety reasons. it is not 

recommended to download a recorder using the USB cable while still connected to AC voltage. 

Connect the recorder to the USB port and wait until the model and serial number show in the Devices pane. 

Next select the [Recorder] menu (or right-click on the model/serial number) and select [Download 

Recording]  

       

When the download is completed, a pop-up will ask you to name the recording. A default name is applied, but 

you can change the name. Then choose [OK] 
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You will be asked to initialize at this time. You can choose to initialize now or later.  

Selecting [Yes] will initialize the recorder with the same settings used in the previous recording. 

                                           

 

5) View the data 

The date files are stored on your PC’s C: drive and will be listed in ProVision under the ‘Recent Downloads’ 

heading in the Explorer Pane. 
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Double click on the data file (a check mark will appear in front of the filename) and the Header Report will 

open. The Header Report gives an overall view of what was recorded and has quick links to many reports and 

graphs. Select the [Graph] or [Report] menus for more options. For more in depth information, refer to 

Working with Data Files, Working with Graphs, and Working with Reports later in this manual. 

 

              

The basic features of ProVision allow the new user to get up and running quickly. 

Remember to perform a [Disconnect] on any remote recorders to start or restart a recording.  
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Using ProVision® 

 

 

                     ProVision User Interface 

1. ProVision Version and Build number 

2. Menu Toolbar:  

File, Edit, View, Report, Graph, Tools, Options, Recorder, Scheduler, Window, and Help menus 

3. Standard Buttons:  

Create a New Project, Open, Save, Save as, Trace Mixer Template,File Merge, Print Now, Print Preview, 

Cut, Copy, Paste, Delete, Edit Report Header, Find in Files, Undo, Redo, PQCanvass, Send Via Email, 

Receive Via Email, and Sync Mobile buttons 

4. Graph Annotation Buttons:  

Pointer For Annotation, Text, Annotation, Horizontal Line Annotation, Vertical Line Annotation, Arrow Menu 

Tool, Line Annotation, Pointer Annotation, and X, Axis Annotation buttons 

5. Advanced Buttons:  

Capture View, Scale Factor, Trace  Mixer Graph, Legend Editor, and Select Plot buttons 

6. Waveform Buttons:  

V/I Waveform, Real Power Waveform, Harmonic Graph, Vector Graph, Parametric Waveform, and 

Record Waveform buttons 

7. Recorder Buttons: 

Recorder communication settings, Retrieve Settings, Initialize, Identify, Date and Time, Standby, Ready, 

and Add Event 

8. Communication Group Pane:  
Displays the status of communication tasks. 

9. Explorer Pane:  

Watcher folders, Recent Downloads, Graphs and Reports, Projects, Searches, Imported Files, Deleted Files 
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10. Devices Pane:  

Recorder Initialization Settings, Events, connected recorders 

11. Main Workspace:  

Main workspace where all graphs and reports will open 

12. Provision Shortcut Pane 

Add and remove commonly used graphs 

13. Properties Pane:  

Properties of currently viewed graph 

14. Status Bar  

Date, Time, and ProVision Intercommunicator Status 

 

Shortcut Pane, Menu Pane, Device Pane, and Properties Pane. These can be pinned or unpinned so that they 
are either always displayed or automatically minimized when the cursor is moved away from them. 
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Customizing the Workspace  

The ProVision® application window is fully customizable to suit individual preferences.    

• All toolbars and window panes may be moved and docked to other locations or may be left free floating 

anywhere on the desktop. They may also be hidden from view if they are not needed.  

 
Right click in a windowpane to see menu  

• Use the [View] menu to hide and unhide each of the windowpanes and status bar. Hidden items will not 

have a check mark.     

• Customize the toolbars from the popup menu to add or remove buttons or to lock the toolbars in place.  

 
Right click in the toolbar area to see menu 

• When docked the window panes may be placed in Auto Hide mode by clicking on the pin icon located in 

the upper right corner of the pane. The hidden window panes can be found on the left or right side of the 

ProVision window        auto-hide   pinned in place. 

• Use the full-screen mode to maximize the viewing area by clicking on the [View] menu, and then clicking 

on [Full Screen].  

Using the Explorer Pane  

The Explorer Pane is the main window for organizing system data. It displays all information in a tree view 

allowing easy access to every part of the system, except PMI recorders, which are managed with the Devices 

pane.  

The Explorer pane is fully configurable and contains several system folders to assist in managing data. 

• To open or close the Explorer, click on the [View] menu, and then click Explorer. A check mark appears 

when the pane is open. The Explorer may also be closed by clicking on the X button in the upper right 

corner of the pane next to the pin button..  

• To toggle the Auto-Hide feature, click the pin icon in the upper-right corner of the pane (Explorer must be 

docked to a side of the application window to use this feature).    

• When in Auto Hide mode, Explorer will automatically slide out of sight when the mouse is moved away 

from the pane. Explorer will slide back into view when the mouse cursor is placed over the Explorer 

button located on the side of the application window.  
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• To move the Explorer pane to another location, click, hold, and drag the upper bar of the pane. The pane 

may be docked to another side of the application window, or may remain free floating anywhere on the 

screen  

• To save space, panes may be grouped together forming a "tabbed pane" arrangement.  

• To resize the Explorer, move the mouse cursor over the pane's border. When the cursor changes into a 

double-headed arrow, click, hold, and drag the border to the desired size.  

Understanding System Folders  

System folders permanently reside in the Explorer Pane and are the major components to the data system of 

ProVision. These folders may not be moved, copied, hidden, or deleted from the system.  

Data File Sources Folder - Watchers 

This folder  contains the locations of data files to be monitored or watched by ProVision.  Each “watcher” 

icon   represents a directory on the local computer or network drive. Recent Downloads is the default 

‘watcher’ folder. 

Creating a network ‘watcher’ is an easy way to share data files with other co-workers.  

To add a new ‘watcher’, right-click on the Data File Sources heading and click Add Watcher. 

 

 

 A browsing window will appear, select the folder to watch.  

Note: Watchers should not be named the same, rename the folder before adding a duplicate watcher 
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Once the folder is selected, another window will ask if this watcher is recursive. Selecting Yes will add the new 

folder and any subfolders. Selecting No, and only the selected folder’s data files will be available to ProVision. 

 

To remove a watcher, right-click on the watcher icon and then click Delete Watcher on the popup menu.  

Watcher icons may be hidden from view by right-clicking on the watcher icon, and then check the Hidden 

menu item on the popup menu. To view hidden icons, click on the View menu, then check the Show Hidden 

Nodes menu.  

You can ‘drag and drop’ or ‘copy and paste’ data files from one watcher to another. Dragging a file, moves the 

file to the other watcher. To create a second file, use the ‘copy and paste’ commands.  

When you download a recorder, you can choose which watcher folder the data file will be stored in.  

Graphs and Reports Folder  

This folder  contains custom graph templates, custom report templates, views and publication templates. 

Folders may be created in the Graphs and Reports system folder to help organize the graphs, reports and 

views that are created.    

 

To create a folder, right-click on the Graphs and Reports icon, or on an existing folder, and then click Create 

Folder from the popup menu. From the menu bar, click on File and then click Create Folder. From the toolbar, 

click the Create Folder button.  

To remove a folder, graph, report, or view, select the item and press the Delete key, or right click on the icon 

and then click Delete from the popup menu. From the menu bar, click on Edit and then click Delete.  From the 

toolbar, click the Delete button.  

Icons may be hidden in the Graphs and Reports folder by right-clicking on the icon, and then checking the 

Hidden menu item on the popup menu. To view hidden icons, click on the View menu, then check the Show 

Hidden Nodes menu. 
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Custom Graphs will also be shown under the Graph/Custom Graphs menu. To edit a custom graph, select the 

listing in the Graphs and Reports folder.  

Projects  

This folder  contains project folders that are used for managing data files. It is structured in a hierarchical, 

tree-like fashion allowing projects and subprojects to be created as needed.   

Data files that are directly selected outside of ProVision and not selected from a Watcher folder are placed in 

the Temporary Projects folder. Projects are links, not copies of the data file. These files may then be moved or 

copied to any other project folder.  

To create a folder, right-click on the Projects icon, or on an existing folder, and then click Create Folder from 

the popup menu. From the menu bar, click on File and then click Create Folder. From the toolbar, click the 

Create Folder button.  

To remove a folder or a data file, select the item and press the Delete key, or right-click on the icon and then 

click Delete from the popup menu. From the menu bar, click on Edit and then click Delete. From the toolbar, 

click the Delete button.  

Icons in the Projects folder may be hidden by right-clicking on the icon, and then checking the Hidden menu 

item on the popup menu. To view hidden icons, click on the View menu, then check the Show Hidden Nodes 

menu.  

Data files may be copied or moved between projects at will. Project folders may be renamed as needed.   

 

Searches  

This folder  contains searches saved using the ‘Find in Files’ command found in the Edit menu.  

Folders may be created in the Searches system folder to help organize searches.   

To create a folder, right-click on the Searches icon, or on an existing folder, and then click Create Folder from 

the popup menu. From the menu bar, click on File and then click New.  

To remove a folder or a search, select the item and press the Delete key, or right-click on the icon and then click 

Delete from the popup menu. From the menu bar, click on Edit and then click Delete. From the toolbar, click 

the Delete button.  

Icons in the Searches folder may be hidden by right-clicking on the icon, and then checking the Hidden menu 

item on the popup menu. To view hidden icons, click on the View menu, then check the Show Hidden Nodes 

menu.  

Imported Files  

This folder  contains data files that have been imported into the system. Use this folder as a temporary holding 

place for imported files until they can be moved to an appropriate project folder.  

As each import operation is performed, a folder is automatically created in the Imported Files system folder 

that represents a directory on the computer system.  
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To remove a folder or a data file, select the item and press the Delete key, or right-click on the icon and then 

click Delete from the popup menu. From the menu bar, click on Edit and then click Delete. From the toolbar, 

click the Delete button.  

Icons in the Imported Files folder may be hidden by right-clicking on the icon, and then checking the Hidden 

menu item on the popup menu. To view hidden icons, click on the View menu, then check the Show Hidden 

Nodes menu.  

Deleted bin  

The Deleted bin  contains all items that have been previously deleted by the user, but have not yet been 

permanently removed from the system.    

All items in the Deleted bin may be restored to their original locations by right-clicking on the item, and then 

clicking Restore from the popup menu.  

All items in the Deleted bin may be permanently removed by right-clicking on the Deleted bin, and then 

clicking Empty Deleted Bin.  

To remove an individual item, select the item and press the Delete key, or right-click on the icon and then click 

Delete from the popup menu. From the menu bar, click on Edit and then click Delete. From the toolbar, click 

the Delete button.  

Icons in the Deleted bin may be hidden by right-clicking on the icon, and then checking the Hidden menu item 

on the popup menu. To view hidden icons, click on the View menu, then check the Show Hidden Nodes menu.  

 

Using the Shortcut Bar  

The Shortcut Bar is a useful tool for storing frequently used items found in the Explorer, such as data files, 

graphs, reports, views, searches and projects. For example, use the Shortcut Bar to quickly launch a commonly 

used voltage graph from the active data file.  

  
   

The Shortcut Bar is fully configurable for easy viewing.  

• To open or close the Shortcut Bar, click on the View menu, and then click Shortcut Bar. A check mark 

appears when the pane is open. The Shortcut Bar may also be closed by clicking on the X button in the 

upper right corner of the pane.  

• To toggle the Auto Hide feature, click the pin icon  in the upper-right corner of the pane (the Shortcut 

Bar must be docked to a side of the application window to use this feature).    
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• When in Auto Hide mode, the Shortcut Bar will automatically slide out of sight when the mouse is 

moved away from the pane. The Shortcut Bar will slide back into view when the mouse cursor is placed 

over the Shortcut Bar button located on the side of the application window.  

• To move the Shortcut Bar pane to another location, click, hold and drag the upper bar of the pane. The 

pane may be docked to another side of the application window, or may remain free floating anywhere on 

the screen   

• To save space, panes may be grouped together forming a "tabbed pane" arrangement.  

• To resize the Shortcut Bar, move the mouse cursor over the pane's border. When the cursor changes into a 

double-headed arrow, click, hold and drag the border to the desired size.  

Shortcut Groups  

The Shortcut Bar can be organized into groups, where a group represents a logical collection of items, such as 

“Reports”, or “ABC Company Data”. A group has a button with the group’s name and contains icons of the 

items added to the group. There’s no limit to the number of groups that can be created, however, groups that are 

not visible on the screen cannot be accessed.  

To create a group, right-click on the Shortcut Bar, then select Add Group from the popup menu. Type a name 

to label the group.  

To remove a group, click on the group’s button to open it, right-click on the group button and select Remove 

Group from the popup menu. Confirm the removal. The group and all items in it will be removed. (The items 

will not be removed from the Explorer.)  

Items may be added to a group by simply dragging the item’s icon from the Explorer into the group. (The item 

is not removed from the Explorer.)  

Items may be added by first selecting the item in the Explorer, then right-clicking in the Shortcut Bar group 

and selecting Add Item from the popup menu.  

Items from the Recent Downloads, Imported Files, and Deleted system folders may not be added.  

To remove an item from the group, right-click on the item, and then click Remove Item from the popup menu. 

Confirm the removal. (The item will not be removed from the Explorer.)  

To resize the icons in a group, right-click anywhere within the group and click Large Icons from the popup 

menu. When checked, the icons in the group will be a larger size.  
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Using the Devices Pane  

The Devices pane is the main window for managing PMI recorders. It displays information in a tree view 

allowing full access to the recorders. 

 

The Devices pane is fully configurable for easy viewing.  

• To open or close the Devices pane, click on the View menu, and then click Devices. A check mark 

appears when the pane is open. The Devices pane may also be closed by clicking on the X button in the 

upper right corner of the pane.   

• To toggle the Auto Hide feature, click the pin icon  in the upper-right corner of the pane (the Devices 

pane must be docked to a side of the application window to use this feature).    

• When in Auto Hide mode, the Devices pane will automatically slide out of sight when the mouse is 

moved away from the pane. The Devices pane will slide back into view when the mouse cursor is placed 

over the Devices pane button located on the side of the application window.  

• To move the Devices pane to another location, click, hold and drag the upper bar of the pane. The pane 

may be docked to another side of the application window, or may remain free floating anywhere on the 

screen   

• To save space, panes may be grouped together forming a "tabbed pane" arrangement.  

• To resize the Devices pane, move the mouse cursor over the pane's border. When the cursor changes into 

a double-headed arrow, click, hold and drag the border to the desired size.   

Understanding the Devices System Folders  

The Devices pane contains two system folders, Events and Recorder Settings, to assist in managing PMI 

recorders.    

These folders cannot be moved or deleted.  

Events  

Th Events folder  contains the list of scheduled events that have been created to perform automated tasks, 

such as performing periodic data downloads from several recorders.  

There is no limit to the number of scheduled events that can be created.  
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Recorder Settings  

Each PMI recorder has settings that determine how and what PQ data to record. These settings can be created 

on-the-fly and stored for future use in the Recorder Settings folder .  

There is no limit to the number of sets of customized recorder settings that can be created.  

As an example, it may be found that at a particular customer site, a recording interval of 1 second is ideal in 
addition to some other parameters. This unique recorder setting can be created and stored for the next time the 
customer site is visited 
 
 

Working with Recorders  
 

Overview 

Only USB cabled devices connect to ProVision automatically. All other devices must be configured in 

ProVision before manually selecting [Connect]. Once ProVision is connected to a device, all devices are listed 

and act the same. It is just a matter of getting the device connected, performing the needed action, and then 

disconnecting the device. 

Connecting Recorders 
 

Connecting a Recorder with a USB cable 

Plug the USB cable into a USB port on your PC or laptop and into the PMI recorder. USB devices will power 

from the USB port. The status LED will become solid green or if it is a Guardian recorder the LED will flash 

red, orange and then green. The recorder name and serial number will auto-populate in the Devices Pane, there 

is no need to [Connect] or [Disconnect] a USB cabled recorder. 

                                                  
                                   USB cabled devices will auto-populate in the Devices pane 

Connecting an RS232 Recorder 

The older RS232 recorders will need an external power supply. An AC wall adapter was shipped with the 

recorder and plugs into the face of the Socket style recorders or into the cable for Box recorders. There are a 

few different cables for different RS232 recorders. Older RS232 cables have a 9-pin connector on one end and 

newer PC’s may not support this type of connector and will need the updated link1 converter cable. Contact 

your PMI sales representative for more information. 
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                          Cables for older RS232 devices may not be supported on your PC 

You can purchase a USB converter cable from PMI that has a USB connector on one end. Connect the RS232 

cable to your PC USB port and the other end to the recorder.  

                                                  
                                                     USB (link-1) Converter cable 

 

The connector on the recorder side may vary depending on the model. The AC wall adapter will plug into the 

black box if connecting to a box recorder or the AC wall adapter will plug into the face of 2S and 3S meter 

socket recorders. 

                                                       
                               An AC wall adapter is needed to power older RS232 devices 

 

Connect an RS232 Recorder to ProVision 

1) In ProVision, select [Recorder] and [Connect Recorder]  

2) For 9-pin serial cables select [RS232 COM1] 

3) For USB adapter cables select [PMI USB Adapter Cable]  

4) View the Communication Group pane in the ProVision Work area to see connection activity 
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                    For RS232 recorder, select [Connect Recorder] and either  

                           [RS-232 COM1] or [PMI USB Adapter Cable] 

 

                         
The Communication Group pane appears in the ProVision work area with connection information. 

The model and serial number will appear in the Devices pane 

Connecting a Bluetooth® Recorder 

The Bluetooth device cannot be powered by a PCs USB port and connect to the same PC using Bluetooth 

communication. Use another PC’s USB port or power the device using a 60V or greater AC voltage source.  

Connecting a Bluetooth device to the ProVision software is a several step process and varies depending on the 

PC’s operating system. 

First connect your PC to the recorder using the Windows Bluetooth selections. Once connected, configure, and 

connect to ProVision.  

Connect the Bluetooth Recorder to your PC  

1) Power the device  

2) In Windows 10, enter Bluetooth in the search area  

3) Select ‘Bluetooth and other devices’  
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               Steps 2 and 3 - Search for ‘blue’, then select [Open] or click in the blue area 

 

4) In the new window, select ‘Add Bluetooth or other devices’  

 
                               Step 4 – Select ‘Add Bluetooth or other device’ 

5) In the new ‘Add a device’ window, select Bluetooth 

           
                                           Step 5 – Select Bluetooth          

 

 

 

 

6) The Device model and serial number will appear when found, select the Device 
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 Step 6 – Your device displays model and serial number when discovered 

7) When asked for a pin or pairing code, enter pmi and select [Connect]  

       

                        Step 7 - Enter ’pmi’ as a PIN and select [Connect] 
 

8) You should see the message ‘Device #### Paired’ or similar message, select [Done] 

 
                           

Step 8 – Confirmation, select [Done] at bottom of screen 

 

 

 

 

9) On the ‘Bluetooth & other devices’ page, move down the page and select 

    ‘More Bluetooth options’ 
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                               Step 9 – Move down the page and select ‘More Bluetooth options’ 

10)  In the new pop-up ‘Bluetooth Settings’, select the ‘COM Ports’ tab  

11)  Write down or remember the ‘Outgoing COM port number’ 

12)  Select [Cancel] and close the Bluetooth windows                   
               

                      

                                        
              Steps 10 and 11 – Select the ‘COM Ports’ tab. Remember the outgoing  

                                            COM port number 

Configure a Bluetooth Recorder in Provision  

Now that you have a COM port number, configure the COM port in ProVision. 

1) In ProVision, select [Recorder] and [Recorder Communication Settings]  

2) Select [Add] and [Serial]  

3) In the Name area, enter the Outgoing COM port number  

4) Use the pulldown arrow to change the Serial Port to the Outgoing COM port number  

5) Set the Baud rate to 57600 or higher 

6) Select the check box ‘This is a Bluetooth connection’  

7) Select ‘Save’  

8) The previous pop-up will have the new Serial entry, [close] this pop-up 
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Connect a Bluetooth Recorder to ProVision 

1) In ProVision, select [Recorder] and [Connect Recorder]  

2) Select the [Bluetooth entry] you created   

 
 Select [Recorder] then [Connect Recorder] and then the Bluetooth entry  

       you created. The model and serial will be added to the Devices pane. Connection  

                                            information is displayed. 

                            Both the Bluetooth Eagle and USB Revolution are shown. 

NOTE: A recorder with red lettering denotes a new firmware is available or the lithium battery voltage is low 
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Connecting a Wi-Fi Recorder 

Connect the Wi-Fi Device to your PC 

First connect your PC to the recorder using the Windows Wi-Fi selections. Once connected, configure, and 

connect to ProVision.  

 

1) At the bottom of your PC or Laptop, select the Network icon 

2) If a PMI Wi-Fi device is within range, the Model and Serial Number will be displayed 

3) Select the device and enter the password 

a) A Wi-Fi Tensor uses the password: pmi12345 

b) A Wi-Fi Guardian uses the password Guardian 
 

 
Configure a Wi-Fi connection in Provision 

This step is only performed once for each recorder model, the Wi-Fi IP address does not change. Recorders of 

the same model use the same IP address. 

1) In ProVision, select [Recorder] and [Recorder Communication Settings] 

2) Select [Add] and [TCP/IP] 

3) In the Name area, enter the serial number of the Tensor 

4) In the Address area, enter the IP address given to you by the PMI Tech Support Team 

5) Select [Save] and [close] 
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        Wi-Fi entry listed as well as previous Bluetooth entry 

Connect a Wi-Fi Recorder to ProVision 

1) In ProVision, select [Recorder] and [Connect Recorder]  

2) Select the [Wi-Fi entry] you created   

                             

 
Select [Recorder] then [Connect Recorder] and then the Wi-Fi entry you created. The model and serial will 

be added to the Devices pane. Connection information is displayed. 

Both the Wi-Fi Tensor and USB Revolution are shown. 

NOTE: A recorder with red lettering denotes a new firmware is available or the lithium battery voltage is low 
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Connecting a Cellular Recorder 

To communicate with your cellular recorder, the cell modem must be set up with a Verizon cell plan. Use the 

SIM and IMEI numbers found in the shipping container when purchasing the cell plan. The default is to use a 

Dynamic IP address, one that changes with every power-on, a public static IP address, which does not change, 

is preferred. Also, an Internal IP address can be supplied to Verizon by your company’s IT group. If configured 

for an internal IP address, your PC must be on the internal network to access the internal IP addresses. Inform 

your IT that the cellular PMI recorders use ports 3141 (and port 11000 with dynamic IPs) for TCP/IP 

communications to the ProVision software.  

 

Configure a cellular IP in Provision 

Contact PMI Technical Support if your cell device is using a Dynamic IP address. 

1) In ProVision, select [Recorder] and [Recorder Communication Settings]  

2) Select [Add] and [TCP/IP]  

3) In the Name area, enter the model and serial number of the cellular device  

4) In the Address area, enter the IP address given to you by Verizon 

5) Select the check box; ‘This is a Cell Connection’  

6) Select [Save]  

7) The previous pop-up will have the new TCP/IP entry, [Close] this pop-up  

8) Repeat for each cell device. 

9) Previously added entries can be edited or removed 

 

                                         Adding a Cell Device to ProVision 
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            Step 7 New cell device is listed with previous Bluetooth and Wi-Fi entries 

Connect a Cell Recorder to ProVision 

1) In ProVision, select [Recorder] and [Connect Recorder]  

2) Select the Cell Recorder entry you created   

 

 
Select [Recorder] then [Connect Recorder] and then the Cell Recorder entry you created. The model and 

serial will be added to the Devices pane. Connection information is displayed. 

Both the Wi-Fi Tensor and Cell Revolution are shown. 

NOTE: A recorder with red lettering denotes a new firmware is available or the lithium battery voltage is low 

 

Connecting an Ethernet Recorder 

For a recorder connected to your local area network using the supplied Ethernet communications cable, upon 

connection, the recorder’s Ethernet IP address is assigned by your network DHCP (Dynamic Host 

Configuration Protocol) Server. The DHCP supplied IP address is Dynamic, meaning that the IP address may 

change when the Revolution is power-cycled or rebooted. In most cases, the IP address will need to be modified 

and set to a Static, or a permanent IP address for ProVision to access it. Your company’s Information 

Technology (IT) department will need to provide the Static IP address to use. Inform your IT that the Ethernet 

Revolution uses port 3141 for TCP/IP communications to the ProVision software.  
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There are two models of Ethernet Revolutions, one will power from the Channel 1 AC connection, the other 

powers from the Ethernet cable and will need a 3rd party 15v Power Over Ethernet (PoE) adapter or a network 

router that supplies PoE. 

Configure an Ethernet IP Address in Provision 

1) In ProVision, select [Recorder] and [Recorder Communication Settings]  

2) Select [Add] and [TCP/IP]  

3) In the Name area, enter the model and serial number of the Ethernet device  

4) In the Address area, enter the IP address  

5) Select [Save]  

6) The previous pop-up will have the new TCP/IP entry, [Close] this pop-up  

 

                            
 Step 6 New Ethernet device is listed with previous Cell, Bluetooth, and Wi-Fi entries 
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Setting the Recorder’s Ethernet IP address using the SNET Utility 

The separate SNET utility is used to set the static IP address when the device is already connected to a network 

and communicating on the default DHCP dynamic IP. Typically the Ethernet devices are located inside a 

private  network and your IT will need to provide the static IP. 

The SNET utility and manual can be downloaded from the PMI website: https://powermonitors.com/downloads 

Contact Technical Support to change the Ethernet IP address when connected using a USB cable. 

                                  
            The SNET utility is used to find the dynamic Ethernet connected PMI devices  

                                          and change them to static IP addresses 

 

Connect an Ethernet Recorder to ProVision 

1) In ProVision, select [Recorder] and [Connect Recorder]  

2) Select the [Ethernet Recorder entry] you created   

 

 
Select [Recorder] then [Connect Recorder] and then the Ethernet Recorder entry you created. The model 

and serial will be added to the Devices pane. Connection information is displayed. 

Both the Wi-Fi Tensor and ethernet Revolution are shown. 

NOTE: A recorder with red lettering denotes a new firmware is available or the lithium battery voltage is low 

https://powermonitors.com/downloads
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Disconnecting a Recorder  

A connected recorder may be disconnected from the system by clicking on the Recorder menu, and then 

clicking on Disconnect.  

The Communication Group pane will display the progress of the disconnection:  
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Managing Recorders  

Managing PMI recorders is easily accomplished with ProVision®. The Devices pane provides the primary 

location for organizing, scheduling, and configuring the recorders. If you do not see the Devices pane, select the 

View menu, and verify Devices is checked. 

Directly under the Recorder Settings system folder is a list of recorder initialization templates. The default 

template is always listed. Users can create their own initialization templates as well as send and receive 

templates to or from other users. 

Under the Local heading is the Events system folder containing all scheduled events for automating recorder 

tasks, such as downloading data and also a list of connected recorders or remote recorders. 

Additional folders may be added to help organize recorders by right-clicking anywhere in the Devices pane, and 

then clicking Create Folder.  

        

     Devices pane showing recorder templates, scheduled events and  

                           recorder being downloaded 

There are two ways to see the available recorder functions; The first is to select the [Recorder] menu at the top 

of ProVision, the second is to right-click on the recorder name (model and serial number in the Devices Pane). 

If there is no recorder name listed, the options will be grayed out except for [Connect] and [Recorder 

communication settings]. 

 

       Options for a connected recorder 
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Using a Recorder  

ProVision provides a sophisticated graphical user interface that expands the usability and management of PMI 

recorders.  

Automating tasks, storing recorder configurations, viewing real-time data, communicating with multiple 

recorders simultaneously, are all features included with the ProVision system.  

All PMI recorders function in one of two operational modes: Standby mode or Ready mode.    

Standby Mode 

The Standby mode is used for configuring a PMI recorder in preparation of recording data. The following 

operations may be performed while in Standby mode:  

• Recorder identification  

• Recorder initialization  

• Data downloading  

• Firmware uploading  

• Setting date & time  

• Retrieving recorder settings  

Ready Mode 

The Ready mode is used when a PMI recorder is actively collecting PQ data. The following operations may be 

performed while in Ready mode:  

• Recording PQ data   

• Displaying real-time PQ data  

Note Normally, it is not necessary to manually change the operational mode of a recorder as ProVision will 

automatically change the mode. 
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Identifying a Recorder  

Identification is a quick and simple operation used to find additional information about a connected recorder.  

Click on the Recorder menu, and then click Identify.  

The Communication Group pane displays the progress of the identification process:  

       

Once completed, click on the View button to display additional information about the recorder:  

                    

Initializing a Recorder  

Initialization is an important operation used to configure a connected PMI recorder prior to recording PQ data. 

Once a configuration has been completed, save it for future use.  

NOTE: Not all selections apply to all recorders. ProVision and the recorders are intelligent devices and will 

only use the selections that apply to that device being initialized.  If a device is connected and a menu selection 

does not apply to that device, the selections will be “grayed out”.  

When the recorder is connected to ProVision, click on the Recorder menu, and then select Initialize. 

The first screen to appear contains the basic settings used to initialize a recorder:  
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Basic Screen 

  

Record Interval  

Select either the Specify Interval button or the Specify Record Time button. For Specify Interval, select the 

Interval time in the pull down which ranges from cycle to 4 hours. The Record Time is displayed and varies 

depending on the interval selection, the Number of Channels selected, and the recorder’s memory. For Specify 

Record Time, select time in the pulldown which ranges from ten minutes to one year. Note: the recorders 

sample at 256 samples per cycle or greater depending on the recorder model, the interval determines how often 

the data points (min, max, ave) are shown in the interval graphs. 

Number of Channels  

Select the numbers to record.   

Current Range  

Select the current range that reflects the type of current probes (Flex CT or TLARs) used is close to the 

expected amperage  

Circuit Type  

The default or no selection will use a wye (phase to neutral voltages) circuit type. To change, select the Enable 

Settings box and then a circuit type. Refer to the hookup diagrams in the Appendices. 

Interval Graph Overwrite  

A check in this box will cause the oldest data to be overwritten once memory is full. Also called FIFO or 

circular mode.  

Report Header  

Four lines of optional text, which will display in the downloaded data on reports and graphs. Uses can include 

addresses, meter numbers, etc.  
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Import  

Select to retrieve a previously stored configuration from memory.  

Export  

Select to store configuration to an xml file which can be used to Import to another recorder or used to create an 

initialization template. 

Restore Default  

Select to reset a particular parameter setting to its default value. Select the parameter to be reset before using 

this button.  

Restore All Defaults  

Select to reset all the settings to their default values.  

Cancel  

Select to close this window without initializing the recorder.  

Advanced  

Select to access additional recorder settings.  

Finish  

Select when changes are completed and ready to finalize initialization of the recorder.  

During the initialization process, ProVision® sends the configuration settings to the recorder and performs 

other tasks to initialize the recorder. The Communication Group pane displays the progress of the 

initialization:  
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Advanced Configuration Settings  

Modifying the default setting will change the record time. Always verify the record time after making changes 

and adjust the Recording Interval as needed. 

Quick links the advanced reports and graphs can be found on the Header Report. 

Note: Most Recorder memory is assigned to Interval Graphs/Strip charts (the Basic screen and Interval Graph 

screen). Waveform Captures, Events, Flicker etc., are assigned separate recorder memory. Changing these 

settings does not affect the Recording Interval time.  

    
 

Interval Graphs  

Check the boxes that you wish to record.   

Harmonic Graphs / Selected Harmonics 

First make your selections of Harmonic Magnitude and/or Phase, then select the harmonics you wish to record. 

Entries can be: All Harmonics (1-51) some recorders have a lower range, smaller grouping of harmonics (1-

25), Specific odd harmonics (3,5,7,9,11) or a mix of both (2-10,25,27). 

Adding Harmonics to the recording drastically changes the record time. 

Recording Interval  

A duplicate of the Basic Screen. Adjust the Recording Interval depending on the selections made. No need to 

go back to the Basic screen. 
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IEEE 519 Recording (Revolution Only) 

Selecting Daily will automatically set the required parameters for 3-second IEEE 519 recordings. Selecting 

Weekly will automatically set the required parameters for 10-minute IEEE519 recordings.   

If any changes are made, verify that Compliant is still indicated. If Not Compliant is shown, then undo the 

changes until Complaint is again shown.  

Not Compliant indicates the recording does not meet IEEE 519 requirements. 

IEC Flicker (Pst Interval)  

Default setting is 10 minutes. Make changes as needed   

 

Waveform Capture 

  

Voltage Threshold  

Enter in the percent of voltage reading that you wish to cause a waveform capture to occur. An example- If your 

unit is on a 120V service and you set the voltage threshold to be 10%, the unit would require a 12V change in 

voltage value to occur from one cycle to the next in order for a waveform to be triggered.  

Current Threshold  

Enter in the percent of full-scale current that you wish to cause a waveform capture to occur. An example- If 

your unit is on a 1000A scale and you set the current threshold to be 10%, the unit would require a 100A change 

in current value to occur from one cycle to the next in order for a waveform to be triggered. 

Voltage THD Threshold 

Enter in the percent of voltage Total Harmonic Distortion reading that you wish to cause a waveform capture to 

occur. 
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Period Capture  

Default setting is Disabled. A selection 1-minute to 4-week will cause the recorder to capture a waveform at the 

selected setting.  

Samples/Cycles  

Some recorders allow a lower resolution (number of points) to be captured, A lower resolution increases in the 

total number of waveforms that can be captured.  

Pre/Post Waveforms  

Default setting is 9-cycles (2-cycles, the trigger cycle, 6-cycles) Enter in the number of cycles you wish to 

capture. Note that recorders have a maximum limit of total cycles in one waveform capture.  

Trigger Thresholds  

Select the number of volts (deviation from previous cycle) that would cause a waveform capture to occur.  

Overwrite  

A check in this box will cause the waveforms to overwrite the oldest waveforms once the waveform memory 

allocation is full.   

Voltage & Current   

Select the number of voltage and current channels to collect waveforms from.    

Example:If you select 2 channels, only channels 1 and 2 will collect waveforms. If your unit has 4 channels, 

channel 3 and 4 will not collect any.   

Changes to the number of channels will adjust the number of waveforms captures available. 

Cross-Triggers 

Selecting Transient Capture will cause a waveform capture to occur when a Transient capture occurs. Note 

that there can be several transients in one waveform capture. 

Selecting Event Capture will cause a waveform capture to occur when an Event occurs. 

 

 

 

 

 

 

 



ProVision® User Manual       45 

Event Capture 

  

Event Recording Parameters  

Nominal Voltage is the voltage against which all events are measured. Factory setting is 120 volts. Adjust to 

match the site’s voltage. 

 

Threshold Bands +/- 

The variations in voltage above and below the nominal voltage set in the first column needed to signal a voltage 

event. Factory setting is 6-volts, meaning that at 120 volts a voltage of less than 114, or greater than 126, will 

create an event. Typical setting is 5% of the nominal voltage set in the first column.  

Minimum Event Time  

The number of consecutive cycles that must elapse before a new event of the same slope can be triggered. 

Factory setting is 10 cycles.  

Enter any changes in the appropriate boxes. The Recorder will record events that meet or exceed your settings. 

The Event Change Table is listed in the Header Report of the downloaded data file.  

Loose Neutral Parameters  

Trigger Duration 

The number of seconds that the condition has to be present for it to be considered a loose neutral.  

Range  

 

Number of volts above or below nominal voltage that the condition would need to be reached to be considered a 

loose neutral. (i.e.- nominal =120v AC and a range of 12 v AC, either  

L1 or L2 would need to be outside of the 108 to 132 v AC range to meet the condition)  
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Difference 

The number of volts that the between channel 1 and channel 2 need to be in order for the condition to be 

considered a loose neutral. (i.e.- L1 would need to be 136 or 104 v AC if L2 was 120v AC to meet the condition 

of a loose neutral)    

 

Flicker 

           

Flicker Parameters  

Contains three columns for each time span in the first column  

Period  

Set the percentage of variation  

Tolerance 

Set the minimum number of cycles  

Limit 

A flicker event occurs when the voltage varies from the nominal by more than the tolerance for more cycles 

than the limit within the given period. For example, using the factory settings for a 10-second period, a flicker 

event would be recorded when five or more variations of more than 1 percent occur within 10 seconds.  

Enter changes in the appropriate boxes.   

The Recorder will record events that meet or exceed your settings. The Flicker Report is listed in the Header 

Report of the downloaded data file 

Note: These settings are for the IEEE Standard 141 report.  Settings for IEC Flicker are in advanced settings.   
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Abnormal Voltage 

 

  

This window displays a chart of low and high abnormal voltage ranges. There are four pages of charts—one for 

each recording channel in use. To switch from channel to channel, click on the numbered tab at the top of the 

charts.   

Standard Settings 

The standard chart lists five nominal voltages (120, 208, 240, 277, and 480). To the left of the nominal voltages 

are columns marked “low range” and “high range.” These numbers determine the values in the five columns to 

the right of the nominals. For example, for the nominal 120, the default low-range setting is 6 and the default 

high-range setting is 12. In this case, a low range abnormal voltage event will be recorded if the voltage is below 

114 or above 126. (That is, 120 volts plus or minus 6, the low-range setting.) A high-range abnormal voltage 

event will be recorded if the voltage drops below 108 or peaks above 132. (Again, 120 volts plus or minus 12, the 

high-range setting.)  

Custom Settings 

The custom scale works much the same way, except you are permitted to change the two nominal voltages.  

If you want the Recorder to use only the settings in the standard chart, check “Standard” at the bottom of the 

page. If you want the Recorder to use only the settings in the custom chart, check “Custom.” If you want the 

Recorder to use both charts, check both boxes.   

The Recorder will record the date and time of voltages which lie outside the ranges you have defined. The 

Abnormal Voltage Report is listed in the Header Report of the downloaded data file 
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Transient Capture  

Transient capture is an option for specific recorders. 

   

Trigger Thresholds  

Select the number of volts (deviation from previous cycle) that would cause a Transient waveform capture to 

occur. Typically set to 2-3 times the nominal voltage. 

 

Misc.  

Selections will change depending on the recorder. 

 

  

 

Channel Names  



ProVision® User Manual       49 

Enter in any tag names for channels.  

Disable Keypad  

A check in this box will disable the unit keypad.  

Display High Resolution  

A check in this box will provide a display with an extra significant digit.  

Use Arithmetic Volts-Amps 

There are two competing methods for resolving the mathematical impossibility of precisely computing 3-phase 

delta apparent power was given. The arithmetic method is the older method but is still seen in legacy meters and 

from manufacturer equipment specifications. The vector method more often gives intuitive results and is the 

default with all PMI power recorders. 

Modem Settings  

For older recorders with a dial-up modem. This is the number of rings the Recorder will wait before answering a 

call. If a Recorder is in a substation with a phone line also used for voice communications, you may want to set 

the ring count higher. That would allow a person the chance to answer the phone before the Recorder modem 

picks up. Factory setting is 3 rings. Modem Initialization Command string can also be set. 

LED Indicator  

This setting has no effect on the Recorder.  

Interval Graph Memory Usage  

Recorder memory is sectioned into several pieces, Interval data (Interval graphs also called strip charts) uses the 

largest memory section in a recorder. Recorders with 1GB of memory can create very large data files if the 

recorder is left recording for an extended period of time. Changing the Interval Graph Memory Usage setting 

can limit the amount of strip chart memory used and create smaller data files, but also shorter record time. 

Rotary Switch Overwrite  

If checked, this feature prevents a user from changing Recorder settings manually from the faceplate keypad, or 

rotary switches on the IV Recorders. Factory setting is not checked (not enabled). For more information see the 

Recorder Manual.  

Significant Change Threshold  

This setting determines the change in voltage needed before the Recorder records a significant change. Factory 

setting is 3 volts. The permitted range is 1-8 volts, with a limit of 1000 events. 

The significant change graph and report data is non-linear, it is based on voltage change and not the Interval 

Record Time. 3-volts for 120, 4-volts for 277 and 6-volts for 480 are common settings. 
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 Email Settings  

 

Recorders with a cellular modem option can be configured with an Email notification option. See your sales 

representative for a cost of this option and contact PMI technical support for configuration.  

CBEMA/ITIC Settings  

 

The CBEMA (blue) and ITIC (orange) curves are both used to visibly represent voltage events. The terms and 

associated curves are used somewhat interchangeably even though there are subtle differences between the two. 

The CBEMA (Computer Business Equipment Manufacturers Association) curve was originally created in the 

1970’s. It defines various regions based on input voltage where computer equipment may encounter operational 

issues. The ITIC (Information Technology Industry Council) curve is a modified version of the CBEMA curve 

created in the 1990’s. It also defines regions based on input voltage but in a clearer fashion with discrete steps. 

Either can be used to create a visual representation of voltage acceptability by plotting the magnitude and 

duration of voltage events. 

Set the number of Channels and the Nominal Voltage. 
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Complete the Initialization  

Select Finish and select Yes to complete the recorder initialization. The Communication Group pane will show 

the progress until completion 

 

Once completed, the recorder is ready to record data based on the configuration that has been set.   

 

Creating a Recorder Template  

Recorder templates can be created to simplify and standardize the initialization process. Once a template is 

created, it can be ‘dragged and dropped’ onto a connected recorder to initialize with the template settings. 

Right-click on Recorder Settings and select Create Template Settings. Choose your recorder and select OK. 

The Initialization Basic page will appear. Adjust the settings needed, select Finish and name the template. 

Custom templates can be shared with other co-workers.  
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Downloading a Recorder  

After a PMI recorder has collected PQ data, it is necessary to download the data to the computer for further 

analysis. Refer to the section Connecting Recorders in this manual to connect ProVision to the recorder for 

downloading. 

Once the recorder is connected, click on the Recorder menu, and then select Download Recording.  

 

 

During the downloading process, the Communication Group pane displays the progress of the operation:  

  

Once the download is complete, enter a name for the new data file. The data file is placed in the Recent 

Downloads folder.  

      

You will be asked to initialize the recorder. Select Yes to remove the old data and start a new recording using 

the same initialization settings on the next power-up or select No to initialize later. If power is applied to the 
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recorder that has not been initialized, the new data will be appended to the old data.   

 

To open the downloaded data file, click the View button in the Communication Group pane or click on the data 

file name under the Recent Downloads folder.   

Retrieve the Settings from a Recorder  

You can retrieve and modify the initialization settings of a recorder. The recorder must be connected before the 

settings can be retrieved. A remotely connected recorder will stop recording when retrieving the settings.  

Click on the Recorder menu, and then click Retrieve Settings.  

         

During the retrieval of the settings, the Communication Group pane displays the progress of the operation:  

Once completed, click on the Export button to save the settings for future use, or click on the Open button to 

view the settings:  
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Verify or modify the settings from the recorder, and then click Finish to initialize the recorder with the changes.    

Setting the Date and Time  

To set the data and time of a PMI recorder, click on the Recorder menu and then click Date and Time.    

The current date and time of the recorder is retrieved and displayed in the following screen:  

  

Editing Box  

Use the editing box to manually change the date and time. Be sure to use a 24-hour time format, e.g. “4:57 PM” 

is “16:57” in 24-hour format.  

Use the drop-down arrow  to choose a date from the calendar.  

Now  

Use this button to overwrite the contents of the editing box with the current date and time.  

Use PC Time 

Check this box to send the date and time of the computer to the recorder instead of the time shown in the editing 

box.  

OK  

Click this button to send the date and time to the recorder.  

Cancel  

Click this button to close this screen without sending the date and time to the recorder.  

During the setting of the date and time, the Communication Group pane displays the progress of the operation:  
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Uploading Firmware  

Periodically, the firmware of a PMI recorder needs to be updated. Use the Upgrade Manager to load all 

Firmware files onto your PC.  

Download any recorder data before updating the firmware. Any data will be removed during the update. 

Auto Firmware update: 

After each recorder download, ProVision will compare the firmware on the recorder with the firmware on your 

PC and if different will ask to update the firmware. 

To manually update the firmware in your recorder:  

Click the Recorder Menu and select Switch to Standby 

Click on the Recorder menu, and then click Upload Firmware. If Upload Firmware is not visible, click on the 

Options menu and then select Show Advanced Operations. 

 

ProVision automatically locates the appropriate firmware file for the recorder, and if a newer version of 

firmware is found, a prompt will appear to verify that it is the one to use:  

  

Click Yes to continue the operation or click No to stop it.  
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During the uploading of the firmware file, the Communication Group pane displays the progress of the 

operation:  

  

Click the Abort button to cancel the operation.  

 

When completed the following message is displayed. 

 

Recording Data  

To begin recording data, the PMI recorder must be connected to 60v AC or greater. 

The recorder must also be placed in Ready mode. 

A PMI recorder is automatically switched to ready mode when it is disconnected from the computer. Either by 

physically removing the USB cable or for remote recorders, performing a Disconnect Recorder in the Device 

menu.  

After disconnecting a countdown from one to two minutes depending on the recorder model, and then recording 

begins. (See the recorder owner’s manual for more information.)  

Another option is to stay connected to the recorder in ProVision and manually select Switch to Ready mode. 

After countdown you can view live data as it is recorded and Disconnect when finished. 
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When a recorder is actively recording, the Device Menu will show Switch to Standby Mode as an option. Use 

this option to stop the recording. Selecting Download Recording, Retrieve Settings, Initialize, or Identify will 

cause the device to Switch to Standby Mode which will interrupt active data recording. 
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Working with Data Files  
Download data file are located under the Recent Downloads heading in the Explorer Tree 

1) To open a data file in Recent Downloads, double click the file name and the Header Report will open in 

the main body of ProVision. A check mark will be placed in front of the data file 

a) Later in this manual you will learn about creating Watcher folders for files located on remote 

network servers  

 

2) To open a data file that is not located in Recent Download, click on the File menu, and then click Open.  

3) A dialog box appears to browse for data files located anywhere on the system. Select one or more files, 

and then click Open.  

4) These data files will be listed under the Projects heading. 

 

5) Once the file(s) are opened, they are considered active and may be used to generate graphs, reports and 

perform other operations.  
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Comparing Data Files 

To compare the data between two or more data files, place a checkmark in front of the files. Then select the 

report or graph to compare. 

 

 

The Graph or Report will open for each selected data file in the ProVision Workspace. Right click on the Report 

or Graph tab and select New Horizontal Tab Group (view one over the other) or New Vertical Tab Group 

(view side-by-side).  

 

 

 

 

 

 

 

 

Reports are easy to compare side-by-side, and graphs compare easily one over the other. 
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To undo the Vertical or Horizontal view, right click on the Report or Graph tab and choose Move to Previous 

Tab Group or select the X to close. 

  

 

File Extensions used by ProVision  

*.ISF: WinScan data files  

*.XSB: Older ProVision data files 

*.XSF: ProVision data files 

*.NSF: Updated Provision data file for Revolution and Guardian+ recorders,  

   also used in PQCanvass   

*.EVM: Used by Custom graphs and Custom Recorder Templates 
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Managing Projects  

If projects or data files become too numerous or cluttered, they may be hidden by right-clicking on the icon and 

then clicking Hidden. These objects are not removed from the system and may be made visible again by 

clicking on the View menu, and then clicking Show Hidden Nodes.  

 

Optionally, projects and data files that are no longer in active use, but must be kept around, may be archived.  

To archive data, right-click on the project or data file icon, and then click Create Archive from the menu.  

 

For items no longer needed, select the icon and press the Delete key, or right-click on the icon and then click 

Delete from the popup menu. From the menu bar, click on Edit and then click Delete. From the toolbar, click 

the Delete button.  

 

Managing Recent Download and Watcher Files 
 

Files downloaded to Recent Downloads or any Watcher folder cannot be deleted in ProVision. You must go to 

the actual location to delete the file. The files downloaded to the Recent Downloads folder can be found on 

your C; drive at this ‘hidden’ folder location: C:\ProgramData\Power Monitors, Inc\ProVision\Common 

An easy way to get to the Recent Downloads location or any Watcher location, is to right-click on the watcher 

name and select Open in Explorer.  The folder will open and all files in that Watcher can be managed just as 

any file on your PC. 
 

 

 

 

 

 

 

 

 

 

 

Generating a Graph  

1) Open a data file or activate a data file in the Explorer by clicking its checkbox. (If more than one data file 

is active, a graph will be generated for each file.)   
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2) Click on the Graph menu, and then click on one of the available graphs, e.g. Voltage and Current in the 

RMS Interval submenu.   

3) A graph will be created for each active data file.   

Hint: If you Zoom into a graph, then right-click and Launch Report, the report will only be for that Zoomed 

in area. 

Note: Custom graphs may be easily created by clicking Custom Graph Wizard in the Tools menu.   

Graph Menu list with First Sub-Menu 
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Generating a Report  

1) Open a data file or activate a data file in the Explorer by clicking its checkbox. (If more than one data file 

is active, a report will be generated for each file.)   

2) Click on the Report menu, and then click on one of the available reports, e.g. the Header Report.   

3) A report will be created for each active data file.   

4) Right click in a blank area of the report to see the Export menu. 

Note Custom reports may be easily created by using the Custom Report Wizard in the Tools menu.   

Report Menu list with First Sub-Menu 
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Advanced Features  

ProVision® contains many advanced features for users who want to get the most out of their power quality 

data.  

The default graphs may be enough for most data reviews, but you may also need to add annotations to highlight 

events or create custom graphs or mixed graphs and also send those graphs to others.  

Working with Graphs  

Graphs provide a visual look at the power quality data that has been recorded.  ProVision’s many powerful features will 

enhance the analysis of the data and improve the presentation of graphs.  

Opening Graphs  

Graphs can be opened by using the quick links on the header report, or by placing a checkmark in the box in 

front of the data file, and then selecting a graph listed under the Graph menu.  

Hint: To compare files place a checkmark in front of multiple data files and then select a graph  

        

Zooming  

On first opening a graph, the complete graph is displayed. To see a close up of a specific event or time you can 

zoom into that area. To zoom into a portion of a graph, click, hold, and drag your mouse directly on that portion 

of the graph then release. This will be expanded to fill the full width of the graph. You can zoom in several 

times. To unzoom one level, press the “U” key on the keyboard once or multiple times to revert more than one 

level. To go to the original view, press the “Z” key. 
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Graph Options 

Right click in a white area of any graph to see shortcuts and other options. Note: After ‘zooming’ into a section 

you can right-click and create a report for the zoomed in area by selecting Launch Report. Also print or save 

that graph view to a file or ClipBoard by selecting Export Dialog. 

 

 

Editing Legends  

The legend of a graph shows the colors of the traces and their meaning.  For example, the legend below shows 

three graphic elements for three of the traces.  “Min V”, “Ave V” and “Max V” describe the meaning of each 

trace, and dark green, green and red are the colors of their respective traces in the graph.   

  

Using the Legend Editor, each legend element can be changed as required. In addition, new elements may be 

added, or existing elements may be removed from the legend.  
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Using the Legend Editor  

To launch the Legend Editor, click on the Tools menu, and then click Legend Editor.  

  

  

  

The Legend Editor has three sections: Legend, Standard and Advanced. Legend  

Use this section to add or remove legend elements by using the + and – buttons, respectively. Each item in the 

list represents a legend element that will appear on the graph.  

Select a legend element from the list to change its properties found in the next two sections.  

Standard  

Use this section to edit the text and color of the currently highlighted legend element. Advanced  

Use this section to alter the data represented by the currently highlighted legend element.  

  

Optionally, hide the legends by checking the Hide legends checkbox.  

Click the Close button when done making changes.  

Graph Annotations  

Analysis of graph data is greatly enhanced when adding comments and other markings to draw attention to 

points of interest. To do this, ProVision® provides a number of graph annotation tools.  

In addition to being able to annotate graphs, graphs with event changes or waveform capture events have 

clickable link annotations. These special annotations allow access to the captured data of the event by clicking 

on the annotation.  

Using Link Annotations  

Link annotations are automatically created in voltage and current interval graphs when event changes or 

waveform capture events are present in the data.  

Each annotation is located on the graph at the point in time when the event change or waveform capture event 

occurred.  
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Event Change Link Annotation  

The annotation symbol for event changes is a gray circle. When clicking on the circle, an Event Change Table 

Report is created for the event change.  

To launch the report, move the mouse over the circle. When the cursor changes into a hand shaped icon, click 

on the circle.  

  

Waveform Capture Link Annotation  

The annotation symbol for waveform capture events is a vertical gray line. When clicking on the line, a graph 

with the waveform capture is created.  

To launch the graph, move the mouse over the line. When the cursor changes into a hand shaped icon, click on 

the line.  

  

Annotating Graphs  

Graphs may be annotated by the user to provide helpful information about the data and to highlight areas of 

interest.  

There are eight annotation tools available on the Graph Annotation toolbar:  
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Annotation Properties 

After selecting and placing the annotation in a graph, select the Properties pane which is located on the right-

edge of ProVision. If you are not seeing the Properties, select the View menu at the top of Provision and place a 

check in the Properties box.  

Each annotation has its own set of items that can be modified. Clicking back in the graph will show the graph 

properties. 

 

 

 

Pointer for Annotation  

Use this tool for selecting or moving a graph annotation already placed on the graph.    

When using this tool, the cursor changes into a hand-shaped icon indicating that the mouse is pointing at a 

graph annotation or a link annotation.  

Text Annotation  

Use this tool to add textual information anywhere on the graph.    

Click on the Text Annotation button, and then click on the graph at the desired location. The words “Text 

annotation” appear on the graph and may be edited in the Properties pane along with other properties.    

After the annotation has been added, the cursor changes into the Pointer for Annotation tool to allow the 

selection and movement of text.  

To remove the annotation, move the mouse over it and right-click, then click Remove Annotation Element 

from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)   
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Properties  

The following appearance and layout properties of the text annotation may be changed in the Properties pane:  

Color – the color of the text  

Horizontal Text Alignment – how the text is horizontally aligned in relation to the insertion point, i.e. the text 

will be to the left, the right or be centered on the point where clicked on the graph.   

Text – the text of the annotation.  

Text Mode – the direction of the text, either “horizontal” or “vertical”.  

Vertical Text Alignment – how the text is vertically centered in relation to the insertion point,  

i.e. the text will be at the top, the bottom or be centered on the point where clicked on the graph.  

Bound to Axis – the Y-axis (see the Y property, below) to which the annotation is attached, either “left” or 

“right”.   

Chart – the plot in which the annotation is located. Plots are numbered from top to bottom, starting with “1”.  

– the X-coordinate of the annotation’s insertion point. The number represents the horizontal location in relation 

to the bottom axis’ unit of measurement, such as “seconds”.  

– the Y-coordinate of the annotation’s insertion point. The number represents the vertical location in relation to 

the left or right axis’ (see the Bound to Axis property, above) unit of measurement, such as “volts”.  

Horizontal Line Annotation  

Use this tool to draw a horizontal line across the graph.  

Click on the Horizontal Line Annotation button, and then click on the graph at the desired location. After the 

annotation has been added, the cursor changes into the Pointer for Annotation tool allowing the selection and 

movement of the line.  

Properties for this annotation may be viewed and edited in the Properties pane.  

To remove the annotation, move the mouse over it and right-click, then click Remove Annotation Element 

from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)   

Properties  

The following appearance and layout properties of the horizontal line annotation may be changed in the 

Properties pane:  

Color – the color of the line.  

Line Type – the appearance of the line, which essentially means the thickness and style, such as a “ThinSolid”, 

dashed or dot line, also line thickness. 

Text – the text associated with the line.  

Text Placement – the location of the text, if any, in relation to the plot, e.g. “CenterInside” places the text 

inside the plot and centered between the left and right sides.  
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Bound to Axis – the Y-axis (see the Y property, below) to which the annotation is attached, either “left” or 

“right”.   

Chart – the plot in which the annotation is located. Plots are numbered from top to bottom, starting with “1”.  

Position – the Y-coordinate of the annotation’s insertion point. The number represents the vertical location in 

relation to the left or right axis’ (see the Bound to Axis property, above) unit of measurement, such as “volts”.  

Vertical Line Annotation  

Use this tool to draw a vertical line across the graph. This is the only annotation that can be created that will 

span across more than one plot of a graph.  

Click on the Vertical Line Annotation button, and then click on the graph at the desired location. After the 

annotation has been added, the cursor changes into the Pointer for Annotation tool allowing the selection and 

movement of the line.  

Properties for this annotation may be viewed and edited in the Properties pane.  

To remove the annotation, move the mouse over it and right-click, then click Remove Annotation Element 

from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)   

Properties  

The following appearance and layout properties of the vertical line annotation may be changed in the 

Properties pane:  

Color – the color of the line.  

Line Type – the appearance of the line, which essentially means the thickness and style, such as a “ThinSolid” 

line dashed or dot line, also line thickness. 

Text – the text associated with the line.  

Text Placement – the location of the text, if any, in relation to the plot, e.g. “CenterInside” places the text 

inside the plot and centered between the top and bottom sides.  

Position – The number represents the horizontal location in relation to the bottom axis’ unit of measurement, 

such as “seconds”.  

 

X – the X-coordinate of the annotation’s insertion point. Select the date to place the line.  

Arrow Annotation  

Use this tool to add one of eight directional arrows to the graph.    

Click on the Arrow Annotation button, and then click on the graph at the desired location. To change the 

arrow type from the toolbar, click on the dropdown arrow next to the Arrow Annotation button and select the 

desired arrow from the list.   

Properties, such as Arrow Type, may be viewed and edited in the Properties pane.  

After the annotation has been added, the cursor changes into the Pointer for Annotation tool allowing the 

selection and movement of the arrow.  
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To remove the annotation, move the mouse over it and right-click, then click Remove Annotation Element 

from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)   

Properties  

The following appearance and layout properties of the arrow annotation may be changed in the Properties 

pane:  

Arrow Type – the direction of the arrow, e.g. the “NorthEast” arrow type points in the upper right direction.  

Color – the color of the arrow.  

Horizontal Text Alignment – how the text, if any, is horizontally aligned in relation to the insertion point, i.e. 

the text will be to the left, the right or be centered on the point where clicked on the graph.   

Text – the text associated with the arrow.  

Text Mode – the direction of the text, either “horizontal” or “vertical”.  

Vertical Text Alignment – how the text, if any, is vertically centered in relation to the insertion point, i.e. the 

text will be at the top, the bottom or be centered on the point where clicked on the graph.  

Bound to Axis – the Y-axis (see the Y property, below) to which the annotation is attached, either “left” or 

“right”.   

 

Chart – the plot in which the annotation is located. Plots are numbered from top to bottom, starting with “1”.  

– the X-coordinate of the annotation’s insertion point. The number represents the horizontal location in relation 

to the bottom axis’ unit of measurement, such as “seconds”.  

– the Y-coordinate of the annotation’s insertion point. The number represents the vertical location in relation to 

the left or right axis’ (see the Bound to Axis property, above) unit of measurement, such as “volts”.  

Line Annotation  

Use this tool to draw a line in any direction desired. The line, however, can only be drawn inside of one plot as 

determined by the Plot property, below. (Other properties may be viewed in the Properties pane, also.)  

Click on the Line Annotation button, and then click on the graph at the desired location to begin the line.  

Next, move the cursor, and then click on a location to end the line.  

To move the line, click and drag the endpoints of the line to their new locations.  Move the cursor over an 

endpoint until the cursor changes into a hand-shaped icon and then click and drag the endpoint.  

After the annotation has been added, the cursor changes into the Pointer for Annotation tool allowing the 

selection and movement of the line.  

To remove the annotation, move the mouse over it and right-click, then click Remove Annotation Element 

from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)   

Properties  

The following appearance and layout properties of the line annotation may be changed in the Properties pane:  



ProVision® User Manual       72  

Color – the color of the line.  

 

Horizontal Text Alignment – how the text, if any, is horizontally aligned in relation to the insertion point, i.e. 

the text will be to the left, the right or be centered on the point where clicked on the graph.   

Text – the text associated with the line.  

Text Mode – the direction of the text, either “horizontal” or “vertical”.  

Vertical Text Alignment – how the text, if any, is vertically centered in relation to the insertion point, i.e. the 

text will be at the top, the bottom or be centered on the point where clicked on the graph.  

Bound to Axis – the Y-axis (see the Y property, below) to which the annotation is attached, either “left” or 

“right”.   

Chart – the plot in which the annotation is located. Plots are numbered from top to bottom, starting with “1”.  

– the X-coordinate of the line’s starting point. The number represents the horizontal location in relation to the 

bottom axis’ unit of measurement, such as “seconds”.  

X2 – the X-coordinate of the line’s end point.The number represents the horizontal location in relation to the 

bottom axis’ unit of measurement, such as “seconds”.  

– the Y-coordinate of the line’s starting point. The number represents the vertical location in relation to the left 

or right axis’ (see the Bound to Axis property, above) unit of measurement, such as “volts”.   

Y2 – the Y-coordinate of the line’s end point. The number represents the vertical location in relation to the left 

or right axis’ (see the Bound to Axis property, above) unit of measurement, such as “volts”.  

Pointer Annotation  

Use this tool to quickly draw a line with text at one end. This annotation is a combination of the Text 

Annotation and Line Annotation tools.  

Click on the Pointer Annotation button, and then click on the graph at the desired location to begin the line.  

Next, move the cursor, and then click on the location to end the line. The word “Pointer” appears on the graph 

and may be edited in the Properties pane along with other properties.  

To move the line, separately click and drag the endpoint of the line (furthest away from the text) and the text 

itself.  Move the cursor over the endpoint until the cursor changes into a hand shaped icon and then click and 

drag the endpoint. Likewise, move the cursor over the text until the cursor changes into a hand-shaped icon and 

then click and drag the text.  

After the annotation has been added, the cursor changes into the Pointer for Annotation tool allowing the 

selection and movement of the line and text.  

To remove the annotation, move the mouse over it and right-click, then click Remove Annotation Element 

from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)   

Properties  

The following appearance and layout properties of the pointer annotation may be changed in the Properties 

pane:  
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Color – the color of the line and text.  

Text – the text of the pointer.  

Bound to Axis – the Y-axis (see the Y property, below) to which the annotation is attached, either “left” or 

“right”.   

Chart – the plot in which the annotation is located. Plots are numbered from top to bottom, starting with “1”.  

Text X – the X-coordinate of the text’s insertion point. The number represents the horizontal location in relation 

to the bottom axis’ unit of measurement, such as “seconds”.  

– the X-coordinate of the line’s endpoint. The number represents the horizontal location in relation to the 

bottom axis’ unit of measurement, such as “seconds”.  

Text Y – the Y-coordinate of the text’s insertion point. The number represents the vertical location in relation to 

the left or right axis’ (see the Bound to Axis property, above) unit of measurement, such as “volts”.   

– the Y-coordinate of the line’s endpoint. The number represents the vertical location in relation to the left or 

right axis’ (see the Bound to Axis property, above) unit of measurement, such as “volts”.  

 

X-Axis Annotation  

Use this annotation to quickly mark a position on the X-axis.  

Click on the X-Axis Annotation button, and then click on the graph at the desired location. The X-axis itself 

doesn’t have to be clicked; the annotation will automatically anchor itself at the X coordinate of the cursor when 

the mouse is clicked.  

The words “Axis Annotation” appear on the graph and may be edited in the Properties pane along with other 

properties.  

After the annotation has been added, the cursor changes into the Pointer for Annotation tool allowing the 

selection and movement of the annotation.  

To remove the annotation, move the mouse over it and right-click, then click Remove Annotation Element 

from the popup menu. (The cursor changes into a hand-shaped icon when the mouse is over the annotation.)   

Properties  

The following appearance and layout properties of the X-axis annotation may be changed in the Properties 

pane:  

Color – the color of the text.  

Text – the text of the annotation.  

X – the X-coordinate of the annotation’s anchor point. The number represents the horizontal location in relation 

to the bottom axis’ unit of measurement, such as “seconds”.  
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Tool Menu  

Select Plots  

Plots of a graph may contain many traces of data points. Sometimes the interesting data is hard to see because 

too much information is in the graph. Therefore, removing the unneeded traces is a good way to emphasize the 

important data.  

To select specific traces of a graph, click on Tools, and then click on Select Plots to bring up the editing 

window.  

  

The Trace section lists all available traces for the graph and what information they represent.    

Highlight each trace in the list to be kept in the graph by clicking anywhere in the trace’s row. Hold the Shift 

key down to select a group of traces at the same time by clicking on the first and last trace in the group. Hold 

the Ctrl key down to select multiple traces one at a time.  

As each trace is highlighted, the grid on the right is updated accordingly.  

The Select by section uses a grid for selecting traces by channel or by type (minimum, average and maximum).  

Use the buttons at the right of the grid to select traces for an entire channel. Use the buttons on the bottom of the 

grid to select traces of a particular type. Use the Select All and Unselect All buttons to quickly select or 

unselect all traces of the graph.  

As traces are selected, checkmarks are placed in the appropriate boxes of the grid. In addition, the list of traces 

on the left is updated accordingly.  

Click OK to keep the changes or click Cancel to ignore them.  
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Trace Mixer Graph or Trace Mixer Template 

It is sometimes useful to select data from different files and combine them into one graph. The combined graph 

is called “mixed” since it merges data from more than one source.  

Sources can be traces of data from a single data file, or they can be from multiple data files.Open the file(s) (To 

use multiple files, place a check mark in front of each of the data files) and open the graphs you want to 

combine.   

Then select the Tools menu, and then click Trace Mixer Graph to launch the mixed graph window. Drag a 

plot from right pane to left pane, select and delete any traces in the left pane, add other plots to the left pane or 

in the pull-down select the other data file and drag plots or individual traces to the plots in the left pane. Select 

OK, new mixed graph will display.  

You can modify the axis and the color of the traces. 

     

Select Trace Mixer Template if you want to combine graphs to create a reusable custom graph (another option 

is to create a custom graph using the Custom Graph Wizard) Select a file and open the graphs you want to 

combine. 

Name the Template then locate and edit the template under the Graphs and Reports heading in the Explorer 

pane.  

 

 

One of the graphs will be transferred to the left pane, modify the left pane as needed. 



ProVision® User Manual       76  

       
Plots 2,3, and 4 removed, and ave real power channels dragged from right pane to Plot 1 on left pane.  

 Move plots and traces from the right pane to the left pane as needed.  

    
 

Moved average voltage from right pane Voltage graph to Plot2 on left pane. Moved average current from right 

pane to Plot3 on left pane. Changed colors to red (ch1), green (ch2) and blue (ch3). 

Select OK to save. To use, select the data file and then select the mixed template located under the Custom 

Graphs heading in the Graph menu. 
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                    Closed data files and template, then edited template, changed Labels 

 
                  Data file using new 3 graph template with Labels  

Scale Factor  

When recording on the secondary, Scale Factor can be used to add multipliers to the Voltage and Current of the 

recorded data to emulate primary voltage and current. Another use of Scale Factor is to correct the direction of 

the Flex CTs or TLARs. If the Flex CTs or TLARs were installed pointing toward the supply side, entering a -1 

in the channel current setting will correct the direction. Another use of Scale Factor is to adjust the Flex CT 

multiplier. If the Flex Ct was wrapped more than once, a setting of .5, .33, or .25 entered in all the current 

settings will adjust the x2, x3, or x4 wrapping in the data file.                                         

Changing the scale factor of the data is easily accomplished. Click on the Tools menu, and then click Scale 

Factor to open the Edit File Parameters window.  
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Use this window to adjust the scale factor for each channel’s voltage and current data for the currently selected 

data file on the left. If there is more than one active data file, select the data file for which the scale factor is to 

be changed.  

Any changes made to the scale factor are immediately applied to all the reports and graphs for the data file.  

  

 

Any changes to the Scale Factor will show in the Header Report of the affected data file. 
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                   Entering a -1 in Channel 2 will correct a ‘flipped’  FCT or TLAR  
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Using the Toggle Point Table  

The point table is a handy reference to view the exact values of a graph at any given point.    

To turn the point table on or off, right-click on the graph and then select Toggle Point Table from the popup 

menu.  Alternatively, use the Alt+T shortcut key combination if the graph is currently selected.  

 
Right-click in a graph to bring up menu 
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The point table appears to the right of the graph and lists all values of every trace at the current time. The 

current time is indicated by a black vertical reference line.  

To change the time, move the mouse over a trace of data points. When the cursor changes into a hand-shaped 

icon, click the trace to move the reference line.  
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Properties Pane  

The Properties pane is located on the right-edge of ProVision. If you are not seeing the Properties pane, select 

the View menu at the top of Provision and place a check in the Properties box.  

All graphs and graph annotations have properties, e.g. the title of the graph, that can be changed as needed. To 

make these changes easy, the Properties pane displays all available properties in a simple, editable grid:  
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Custom Graph Wizard 

Custom graph templates are easily created by using the custom graph wizard.  

The custom graph wizard helps to easily create graph templates that may be used repeatedly to generate custom 

graphs.  

From the Tools menu, or by right-clicking on the Graphs and Reports folder in Explorer, click on Custom 

Graph Wizard to begin.    

 

Use the following steps to complete the wizard.  
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Add Plots to Graph  

Each graph will contain one or more plots on which to display graphical data. Each plot, for example, may 

represent data from each channel of the recording.  

There may have up to 6 plots of data on a custom graph. Add or remove plots as needed using the buttons 

above.  

A preview of the custom graph is on the right and is updated as changes are made. The red, vertical bar shows 

which plot is currently highlighted.  

Click the Next button to continue customizing the graph or click Finish to complete the changes. Click Cancel 

to end the wizard.  
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Add Axes to Plots  

Every plot should have at least one vertical, or y-axis, to describe the type of data being displayed. Usually, this 

axis is on the left, however, it can be shown on an axis on the right side of the graph or even show axes on both 

sides of the plot to display two types of data.  

For each plot in the graph, decide if there is to be an axis on one or both sides. Then, for each axis, give it a 

name in the Label field and choose what kind of data is being displayed, e.g. voltage, current, power, etc., from 

the list of available quantities in the Quantity field.  

As the graph is customized, the changes will update the graph preview screen to the right. The red, vertical bar 

shows which plot is being modified.  

Click the Back button to return to the previous screen.  Click the Next button to continue customizing the graph 

or click Finish to complete the changes. Click Cancel to end the wizard.  
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Adding Traces to Axes  

Every axis added to the graph will have one or more traces, or lines, of data points associated with it. Traces of 

similar data, such as the maximum data points for all four channels, may be displayed on one axis.  

For each plot of the graph, choose which data channels and data point types (minimum, average and maximum) 

will be displayed for the left and right axes, as applicable. Use the square buttons to quickly select or deselect a 

row of data point types or a column of data channels.  

As traces are added or removed, the graph preview on the right is updated accordingly. The red, vertical bar 

shows which plot is being modified.  

Click the Back button return to the previous screen. Click the Next button to continue customizing the graph or 

click Finish to complete the changes.  Click Cancel to end the wizard.  
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Trace Properties  

Individual traces of data points have customizable properties. The color or the style of each line can be changed 

to make certain data stand out more than others.  

Look at the traces for each plot of the graph and change the line color or line style of the traces as needed.  

As the color or style of a line is altered, the graph preview on the right will update to show the changes. The red, 

vertical bar shows which plot is being modified.  

Click the Back button return to the previous screen. Click the Next button to continue customizing the graph, or 

click Finish to complete the changes. Click Cancel to end the wizard.  
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Add Legends  

Legends describe what particular trace color represents, e.g. a red trace may be the maximum voltage for all 

channels.  

Use the list on the left to change the color and text of each legend. Legends may be added or removed, and their 

properties may be changed, too.  

As changes are made to the legends, the graph preview on the right will be updated accordingly.  

Click the Back button return to the previous screen. Click the Next button to continue customizing the graph, or 

click Finish to complete the changes. Click Cancel to end the wizard.  
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Graph Title  

Give the graph a title which will be displayed at the top. Since the customized graph will be saved as a template 

for future use, it is necessary to give the template a name, too.  

Enter a title to be displayed at the top of the graph. Any changes made to the graph title will be shown in the 

graph preview on the right.  

Also, type a name for the template that will appear in the Graphs and Reports folder.  

Click the Back button return to the previous screen. Click the Next button to continue customizing the graph or 

click Finish to complete the changes. Click Cancel to end the wizard.  
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Wizard Finish 

Congratulations!  A custom graph template has been successfully created.  

To locate this template, go to the Graphs and Reports folder in Explorer. Select a data file and double-click 

on the template icon  to create a custom graph or select the Custom graph under the Graph menu – Custom 

Graphs. The report for this new custom graph is located under the Report menu – Custom Graph Reports 

 

NOTE  

Not all files will contain the data requested by the graph template.  

Click on the Finish button to end the wizard.  
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Working with Reports  

Reports provide a tabular presentation of data from a PQ data file. All reports are listed under the Report menu 

tab including reports from custom graphs. Reports can also be created from a graph or portion of a graph by 

right-clicking in a white area and selecting Launch Report. 

Exporting Data  

It can be useful to present a report in other applications, such as Microsoft Word or Excel.  

In addition, rich-text format (RTF), hypertext markup language (HTML) and comma-separated values (CSV) 

are also available for export.  

To export a report into one of these formats, simply right-click on the report and choose the format from the 

popup menu. A new window will appear for the appropriate application with the report data. (Applications like 

Word and Excel are assumed to be installed on the computer.)  
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Or open a report and select the File Menu and then the Export Menu. 

 

Using the Graph and Report Publisher Wizard  

The Graph and Report Publisher wizard easily creates templates that may be used repeatedly to generate custom 

graphs and reports as RTF documents.  

From the Tools menu, or by right-clicking on the Graphs and Reports folder in Explorer, click on Graph 

and Report Publisher to begin.    
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Choose What to Create  

To generate a custom Graph and Report template, or to generate a custom Graph and Report from a specific 

data file, select the specific graphs and/or reports from the main screen. 

                            

 

As you highlight them, move them to the right column using the arrow. Use the Down and Up buttons to 

arrange the order of selected graphs and reports   
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Any custom graphs and reports previously created are listed, or create a new custom graph and report using the 

Launch Graph Wizard button. 

Select the Next button 

The Header and Footer for each select graph or report can be modified. Company logos or pictures can be 

added. 

 

Name the publication and select Finish. The template will be located in the Explorer pane under the Graphs and 

Reports heading. Select the data file and select the custom report and graph template, name the file and save the 

file. 
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Working with Views  

A view is a template that will create any combination of graphs or reports from an active data file and then 

arrange them on the screen as they appeared when the view template was first created.  

For example, if there were a couple of reports and a graph that were used on a regular basis, they could be 

arranged on the screen in any way desired, such as having the two reports side by side in the upper half of the 

window and the graph in the lower half. This arrangement constitutes a view and can be saved for future use on 

other data files.  

The default view provides a template for data files when they are opened. The default view is indicated by a 

white checkmark on the icon .  

To create a view, arrange the graphs and reports on the screen as desired. Click on the Tools menu, and then 

click Capture View. A new view icon  will be created in the Graphs and Reports system folder. Right click 

on New View to rename, then right click and then set as the Default View. (The check mark will move from the 

default or previous view to the new view).  

 

In this example, whenever a data file is opened by double clicking on it, the 3 Report view will be used, and 

three reports will open at one time. 
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Searching for Data  

Locating data from hundreds of data files can be a difficult task. Use the Find in Files utility to search data files 

based on specific criteria:  

Click on the Edit menu, and then click Find in Files to launch the search window:  

  

In the example above, the search will look at data files that have recorder models “ViP” and “Eagle”, and use 

the “100 A” current range. Click the Find button to begin the search.  

The search criteria can be saved for future use by clicking on the Save Query button. Enter a name for the 

query, which will then be stored in the Searches folder.  

 

The results of the search can also be saved by clicking on the Save Result button. Enter a name to label the 

results folder in which the found data files will be stored. This new folder will be located within the Projects 

system folder.  
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Importing Data Files  

Data files that exist on the computer system are easily imported.  

Click on the File menu, and then click Import to browse the system for the location of the data files:  

  

For any location on the computer system chosen, all folders beneath it will be searched for data files, also.  

Merging Data Files  

File merge will combine two or more ProVision recordings into a single combined recording. File merging 

works best when the recordings are from the same device with the same settings. This is intended for files from 

the same recorder during different time periods, most commonly a “before” and “after” situation. It can also be 

used to combine multiple files from scheduled periodic downloads.  

First select the data files you want to merge by checking the box in front of the data files. Next, open the File 

Menu and select File Merge. Name the combined file and open the new file to review the data. 

Not all data record types can be merged. 
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Viewing Real-Time Data  

Real-time data capture is a powerful tool to view PQ data being measured “right now” by a recorder in a 

graphical and tabular format.    

The Waveform Graph menu contains several graphs to present an overall view of the circuits being monitored. 

The Meter Display menu contains several displays of tabular data to view numerical readings.  

Waveform Graph  

Five graphs are available for displaying real-time data:  

• Voltage & Current Waveform  

• Real Power Waveform  

• Phasor/Vector diagram  

• Harmonic Graph (also known as harmonic bar graph or FFT Graph)  

• Parametric Waveform  

To access these graphs, ensure that the recorder is connected. Next, click on the Recorder menu and then 

click Waveform Graph to select one of the graphs.  

  

Real-time Voltage & Current Waveform       Phasor/Vector Diagram  
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Harmonic Graph     Parametric Waveform  

  

Meter Display  

Five displays of tabular data are available:  

• Main Readings  

• IEC Flicker Readings  

• Harmonics, 1st – 8th  

• Harmonics, 9th – 16th  

• Diagnostics  

  

 

Main Readings                                    IEC Flicker Readings  
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Harmonic Readings                                     Diagnostics  

  

To access these tables, ensure that the recorder is connected and powered. Next, click on the Recorder menu 

and then click Meter Display.   

Note  

Not all PMI recorders are able to display real-time data. For real-time enabled recorders, the Waveform Graph 

and Meter Display menus will be enabled and available.  

  

 

Archiving Data  

It may be necessary to remove old PQ data from the system. To do so, use the archiving feature to store project 

data files to any location. All archived data is fully recoverable.  

To archive data, right click on the project folder to be archived, and then click Create Archive from the popup 

menu. Follow the wizard screens to complete the task.  

To restore an archive, right-click on the Projects system folder, and then click Restore Archive from the popup 

menu. Then, browse to the location of the archive.  
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Preferences  

In the Options menu choose Preferences to set selections which remain when ProVision is re-opened. 

In the General settings, turn off the Check for Updates, or elect not to see the Splash Screen. Demand 

Interval can also be adjusted from the default 15 minutes/900 seconds.  

In Graph Properties, choose to Skip First and Last Graph Points. 

 

In Recording Preferences adjust the default file naming convention or add a 12 hour time to the default name. 

You can choose to save the data file using the new NFS file format.  
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Scheduling Events  

Events are useful to perform automated recorder operations at a specified time.  

Note: To use the Scheduler, the ProVision Communicator service will need to be installed when installing 

ProVision. 

Click on the Scheduler menu, and then click Add Event.  

          

 

The Scheduler window appears for creating a scheduled event with any number of recorders:  

                               

  

Start Time  

Select the date and time to begin the event.  

Action  

Select one of two event types: Recording Download or Settings Upload.  

• Recording Download will automatically download a PQ data recording from the recorder.  

• Settings Upload will automatically upload recorder settings to the recorder.  

Comment  

Provide a comment to uniquely describe the event.  
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Recurrence 

Specify how often the scheduled action occurs 

 

Recorder Setting 

Configure an initialization template to use  

Edit List 

The list of recorders to be included in the event. 

  

 

Save and Close  

Stores the event and closes the window. The newly created event may be viewed and edited from the Events 

system folder in the Devices pane:  
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Types of Records 

PMI recorders can record many different kinds of power quality data during a recording session.    

Interval Records  

The interval record is one of the most useful record types. In a single interval graph, power quality events can 

be seen such as single-cycle voltage sags and current surges, as well as long term voltage trends. With the 

graph, an entire recording session can be examined at a glance.  

What's Recorded  

The only setting for the interval record is the Recording Interval. This Interval, which can be as small as one 

second to as large as four hours, determines how often the Recorder takes a data point.  Every interval record 

the Recorder is recording uses the same Interval setting.  During the Interval period, the Recorder keeps a 

history of the largest and smallest one-cycle values for each interval record, as well as a running average. At the 

end of the Interval, the max, min, and average values for that time period are recorded as a data point. For 

example, if the Recording Interval is set to one minute (a typical setting), at the end of each minute, the Voltage 

Interval Record will record the average RMS voltage, the minimum one-cycle RMS voltage, and the maximum 

one-cycle RMS voltage, all during that minute. All of the 3,600 60Hz cycles during that minute are used to 

calculate the average, and for max/min detection.  

These values are presented to the user as three traces on a graph:  a maximum, a minimum, and an average. The 

average trace roughly corresponds to a graph from a paper stripchart recorder. The maximum and minimum 

graphs are unique, however. Each gives the worst-case value for every Interval, with single-cycle measurement 

resolution.  

Each Recorder has at least enough memory to record interval records for a week with a one-minute Interval.  

When the interval record data fills the interval record memory, the Recorder has two options: it can either stop 

recording interval records or go into "wrap-around" mode. In "wrap-around" mode, the oldest data points are 

erased to make room for the new ones as they are collected, which allows the Recorder to always have the latest 

data. This choice is made by the user during the Initialization. If the Interval Graph Overwrite (Circular) box 

is checked, the Recorder will go into "wrap-around" mode as needed, otherwise it will stop recording when 

memory is full. This does not affect other record types. For example, if there is memory for one week of 

interval records, and the Recorder was left in the field for three weeks, it would either have the first or the last 

week's interval record data, depending on the wrap-around setting.  

Every Recorder can record an interval record of voltage. Some Recorders can also record an interval record of 

current.The ViP can also record interval records for real, reactive, and apparent power, power factor, phase 

angle, THD, and harmonics. The ViP, with harmonics, can record over 200 interval records at once. Typically, 

only a few are needed at one time. All the interval records share the same memory, so enabling more interval 

records reduces the total interval record recording time.  

When creating an interval graph or report, any "gaps" in the data due to a power outage are filled with zeroes.  

This happens when the Recorder loses power, and its rechargeable battery (if present) runs down.  

Typical Settings and Suggested Uses  

There are three settings for the interval record types. The primary setting is the Recording Interval. This time 

setting determines how often the data is recorded. Since the recordings always give worst case one-cycle max 
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and min values, the Interval can be set to any time value without a loss of measurement resolution. For example, 

even if the Recording Interval is set to 15 minutes, the maximum and minimum one-cycle RMS values for each 

15-minute period are recorded. What is lost by setting the Interval to larger values is time information. If there 

is a voltage minimum of 90 volts RMS during a recording interval, with the Interval set to 15 minutes, it’s 

certain that the voltage dipped that low for at least a cycle, but it’s not known when or how often or how long 

during those 15 minutes it happened. A smaller Interval, such as one minute, provides a finer time resolution.  

The smallest Interval, one second, gives excellent time resolution, but consumes memory 60 times faster than a 

one-minute setting. Often, the exact time of a voltage dip is not as important as the size -- for this case, any 

reasonable Interval setting is fine.  

The most common setting is one minute. This is a good balance between frequent data collection and long 

recording time. Since most loads that start and stop usually run for longer than a minute, the start and stop 

effects (such as in-rush current) are easily spotted in the Recording. An example is an air conditioner load: a 

forty minute period of cycling on and off is obvious in the interval graph as twenty data points at one load 

current, then twenty data points at low current, all connected by straight lines on the graph. The first interval of 

the high current period will probably have a much larger current maximum than the rest due to the starting 

current of the air conditioner. The voltage interval will probably have a dip at the same time.  

The most frequent reason to use an Interval smaller than one minute is for large loads that cycle on and off more 

frequently than one minute. For example, if an elevator is causing power quality problems, and it only takes 10 

or 20 seconds to start at one floor and stop at another, a one second Interval is probably necessary; otherwise the 

entire elevator travel will occur during a single Recording Interval.  In this case, the Recorder should not be left 

to record for days, since it would only hold the last few hours of Interval data. The best use in this case is to set 

the Recording Interval to one second, then cycle the load (such as the elevator) for a while, in an attempt to 

reproduce the problem, and then download the Recorder. In general, the Interval should be smaller than the 

quickest cycling time of a problem load.  

The most frequent reason to use an Interval larger than one minute is to increase the recording time. Setting the 

Interval to two minutes doubles the recording time, without a serious loss of time resolution. Other common 

settings are five and fifteen minutes, used to match metering or billing increments or regulatory time periods.  

The second interval recording setting is the Interval Graph Overwrite mode. The best setting for this depends on 

how the Recorder will be used. Some users leave a Recorder at a problem site until the customer calls with a 

power quality complaint. The Recorder is set to a small Interval such as one minute or thirty seconds and 

Overwrite is enabled. Because Overwrite is enabled, the interval records always have the latest few days of data 

in memory, by discarding the old data. The Recorder is downloaded and has the most recent days of interval 

data in memory, no matter how long it was recording. This recent data will have the voltage disturbance in it.  

Other users will disable Overwrite and leave a Recorder at a problem site where the power quality problem will 

definitely occur soon. The Recorder will record the first week or so of interval record data, then stop recording.  

The Recorder can be downloaded at any time later, knowing that the beginning of the recording session is 

locked in memory, and will not be overwritten. Other users always download the Recorder before it fills up 

interval record memory, which makes the Overwrite setting irrelevant. The choice depends on how the 

Recorder will be used. The factory default setting is for Overwrite to be enabled.  

The third interval record setting is which interval records are enabled. For voltage-only Recorders, there is no 

choice: a voltage interval record is always recorded. For Recorders that can record current, the current interval 

record can be turned off to extend the recording time of the voltage interval record. It is usually better to 

increase the Interval time instead of disabling current to get more recording time. For the ViP Recorder, there 

are many more interval records to enable or disable. The choice depends on what information is needed. If a 

power factor study is being performed, for example, turn on power factor, and possibly apparent power and 
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displacement power factor. If a power quality problem is present, only voltage and current may be necessary, 

although adding Total Harmonic Distortion (THD) may be useful to see if harmonics are present. The total 

recording time is shown by ProVision® as interval records are enabled and disabled during the Recorder setup.  

Another method to increase interval record memory is to reduce the number of recorded channels. If only three 

channels are needed on the ViP, changing the number of channels from four to three gives 25% more recording 

time.  

For quantities such as power factor, phase angle, THD, etc., often the average is much more important than the 

one-cycle max and mins. The max and min traces on the graph may be turned off so that they don't obscure the 

average trace.  

Daily Profile Records  

The Daily Profiles are used to spot daily trends in voltage, current, power factor, etc. The entire recording 

session is combined to form the "average" 24-hour day, which is plotted on a graph like a strip chart. Power 

quality issues are usually not addressed with Daily Profiles (except perhaps consistently low or high line voltage 

or harmonic distortion). Rather, average line conditions such as regulation voltage, load current, etc. are 

profiled.  

What's Recorded  

Each measured quantity has only one Daily Profile per channel in a recording session. For example, there are 

four voltage Daily Profiles in a recording session, one per channel. The Profile is averaged over the entire 

recording session. This average is created by dividing the 24hour day into 96 time periods, each 15 minutes 

long. During each 15-minute period, the Recorder computes the average value for that Profile (voltage, current, 

etc.). This 15-minute average is then averaged with all the previous days' averages of that 15-minute period.  

For example, the first Voltage Daily Profile data point is the average voltage during the 15-minute period from 

12:00am to 12:15am, averaged again over the entire recording time. If a Recorder is recording for a week, then 

this 12:00-12:15am period is averaged seven times over the entire week.  

There are no settings for Daily Profiles. All available Daily Profiles in a Recorder are always enabled, 

regardless of the settings for any other record types. Memory does not run out for a Daily Profile; it just keeps 

averaging as long as the recording session lasts (there is a practical limit of about a year). Some Recorders 

record just a voltage Profile, others voltage and current. The ViP Recorder records a Profile for voltage, current, 

real, reactive and apparent power, power factor, displacement power factor, voltage and current THD, and phase 

angle.  

Suggested Uses   

Daily Profiles are typically used to profile or characterize a parameter, such as average load current or power 

factor. Since the Profile is supposed to re reflect average line conditions, the more loads included in the 

recording, the better the average. Monitoring a single small load such as a small office building would not 

create a very good profile of distribution line conditions (such as distribution line power factor), since the 

building would be a small part of the total distribution load. Voltage is somewhat of an exception in that 

anywhere can be a good place to create a profile: every other load (at least those nearby) will see the same 

distribution line voltage. The ideal location for creating power factor profiles is where a PFC would be placed to 

correct power factor.  

The voltage Daily Profile is normally used to identify voltage regulation problems, or other steady-state 

low/high voltage issues. The current Profile can be used to identify daily trends in load current. This is also 
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possible with the apparent power Profile. Power factor and reactive power Profiles can be used to set PFC 

timers to correct for power factor only when necessary during the day. The voltage and current THD Profiles 

show when harmonic distortion is present during the day.  

The more days the Recorder records, the better the average created by the Profile. A recording session that just 

lasts a single day doesn't incorporate any daily averaging at all. Since a Profile starts with all zeros, a recording 

session that doesn't even last 24 hours will include some 15-minute blocks with the data still zeroed. A 

recording session that does not even last 15 minutes will have all zeroes for a Daily Profile.  

An interval recording can also be used for profiling tasks but is not ideal. The recording interval is usually set to 

an interval faster than 15 minutes; a fast interval can show too much information, making it hard to form a good 

average Profile. Often the interval recording only has enough memory for a week or two, limiting the averaging 

time; the Daily Profiles have no such limit. Most importantly, the interval recording does not divide the data 

into an averaged day period, so it can be difficult to spot daily trends in the graph.  

Cycle Histogram Records  

The cycle histograms contain valuable power quality information as well as information for distribution line 

profiling. Questions such as "what was the absolute highest and lowest RMS voltage?", "how many cycles was 

the voltage below 80 volts?", and "what are the most common load currents?" are easily answered. The 

histograms also contain the raw data necessary to answer more complicated statistical questions such as "what 

is the probability of a voltage sag below 100 volts?" and "what high and low limits does the line voltage meet 

99.99% of the time?” Where the Daily Profiles give average current, power factor, etc. for distribution profiling, 

the histograms show what values are the most common -- the "mode" in statistical terms.  

What's Recorded  

A Histogram divides a measurement range into many bins. For example, in the ViP, the voltage Histogram 

divides the 600V voltage range into 600 bins, each one volt wide, giving a bin for zero volts, a bin for one volt, 

two volts, all the way to 600 volts. After each 60Hz cycle is measured, the voltage is rounded to the nearest volt 

and "put" in the appropriate bin. The bins are really counters that count how many cycles were at that voltage. If 

the 108 volt bin has a count of 45, then there have been 45 cycles with an RMS voltage of exactly 108 volts, 

sometime during the recording session. The Histogram throws away time information:  those 45 cycles could 

have occurred anytime during the recording session. They may have been 45 cycles in a row, or three 15-cycle 

sags, or 45 isolated sags spread out during the entire recording session. (To recover the time information, use 

the interval graph or an event-based report.)  

Every interval graph max and min value will have a non-zero count in the corresponding Histogram. For 

example, if the voltage interval graph shows six sags to 108 volts sometime during the recording session, there 

should be a count of at least six in the Histogram at 108 volts. The count will probably be somewhat larger, 

unless each sag was only one cycle long.  

There are no settings for Histograms. All available Histograms in a Recorder are always enabled, regardless of 

the settings for any other record types. Memory does not run out for a Histogram; it just keeps classifying 

measurements into the bins (by incrementing the bin counters) as long as the recording session lasts.  

The 600V (iVS-3/600), the S-series (VS-1S and iVS-1S), and the ViP record a voltage cycle Histogram for each 

voltage channel. The ViP also records cycle Histograms of current, real, reactive, and apparent power, power 

factor, displacement power factor, and phase angle.  
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Suggested Uses   

The power of the Histogram is that every cycle is included in the report. Every cycle during the recording 

session is reflected in the count of one of the bins. If all the counts in a Histogram are totaled, the result is how 

many cycles the recording session lasted (minus any time under a power outage).  

Histograms are presented as a bar graph and a report. The report is in some ways easier to read than the graph.  

The absolute highest and lowest voltages during the recording session are found by finding the highest and 

lowest bins with a non-zero count. At that point it’s known how many cycles the voltage was at those extremes, 

and by glancing at the nearby bins, it’s also known how many cycles the voltage was near those extremes.  For 

example, if all the bins below 110 volts are zero, then it’s immediately known that there was not even a single 

cycle of voltage below 110 volts anytime during the recording session.  If the count at 111 volts is 1,352,200, 

then the voltage was at 111 volts for over 6 hours (1,352,200 = (60 X 60 X 60)). By totaling the counts for all 

the bins in a voltage range (for example, 0 to 90 volts), it’s known how many cycles the voltage was in that 

range.  

More complicated power quality questions can be answered by exporting the histogram data to a spreadsheet.  

By dividing each count by the total of all the counts, the histogram data is normalized, and can represent a 

sample probability distribution function.  If a normal, or bell-shaped probability distribution is fit to this data, a 

standard deviation is created that can be used to answer "what high and low limits does the line voltage meet 

99.99% of the time?". A cumulative sum over the data will convert the distribution function into a sample 

cumulative probability function. Correlations between channels can be performed by comparing the probability 

functions of channels.  

For the voltage histogram, most of the time the user is interested in the few cycles that are outside certain limits, 

not the vast majority of cycles that are perfectly normal. These few cycles usually represent power quality 

issues. The current, power, and power factor histograms are useful for distribution line or load profiling. For 

these histograms, the few cycles at the extremes are usually unimportant: the vast majority in the middle is the 

good data.  

Minute Histogram Records  

The Minute Histogram provides a much "smoother" version of the Cycle Histogram. Quick sags and swells are 

averaged out of the data, to show the nominal voltage or current level every minute. Voltage regulation 

problems are easy to see in the Minute Histogram.  

What's Recorded  

The Minute Histogram is similar to the Cycle Histogram. During each minute of the recording session, the 

voltage is averaged (every cycle is included).  At the end of the minute, the Histogram bin counter for that 

average value is incremented. The result is a Histogram of one-minute average voltages, instead of one cycle 

voltages. For example, if the voltage were 123 volts for 55 seconds, then 115 volts for 5 seconds, the average 

would be 122 volts, and the 122 volt bin counter would be incremented. If the recording interval is also set to 

one minute, then the Interval graph voltage averages will match the Minute Histogram counts.  

Like the Cycle Histograms, there are no settings for the Minute Histogram. All available Minute Histograms in 

a Recorder are always recorded, regardless of the settings for any other record types. Memory does not run out 

for a Minute Histogram; it just keeps classifying measurements into the bins (by incrementing the bin counters) 

as long as the recording session lasts. All Recorders record a voltage Minute Histogram. Recorders that can 

measure current also record a current Minute Histogram.  
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Suggested Uses   

The voltage Minute Histogram can reveal voltage regulation problems. Ideally, the line voltage should be at the 

same value every minute.  The larger the spread in the Minute Histogram, the more the voltage is varying.  The 

center of the spread is (hopefully) the target regulation voltage. This information is also present to an extent in 

the voltage Interval graph, depending on the recording interval and amount of memory. Because the Interval 

graph spreads out the voltage averages as a time graph, it can be more difficult to gauge how long the voltage 

was at certain levels (although it may be easier to see why the voltage was moving).  

The Minute Histogram is also better for this analysis because it does not run out of memory and is always set 

for one minute averaging.  

The current Minute Histogram shows average load current on a minute basis. The maximum and average load 

currents are easily spotted on the Histogram as the edge and the center of the current spread. Again, this 

information is usually in the current Interval graph, but not as easy to see.  

The cycle Histograms can also be used for voltage regulation problems and load profiling, but the Minute 

Histograms can be easier to read since the fast one-cycle events have been averaged out.  

Energy Usage Records  

The Energy Usage report shows the accumulated real, reactive, and apparent power measured by the Recorder.  

The accumulated real power is energy, in kilowatt-hours. The accumulated reactive and apparent powers are 

kilovar-hours and kilovolt-amp-hours, respectively. These totals are for the entire recording session and are only 

available on Recorders which can compute power.  

What's Recorded  

Each cycle, the real, reactive, and apparent power values are computed and added to the running totals for the 

recording session. These values include the effects of voltage and current harmonics. The accumulated powers 

are totaled separately for each channel for a wye hookup. With a delta hookup, the individual phase powers 

cannot be measured, only the total. In this case, the three-phase total real, reactive, and apparent power values 

are totaled and reported.  

Negative power values are included in the accumulation. For example, if a load is both absorbing and 

generating power (at different times, of course), the accumulated power will reflect it. A line that varies from 

leading to lagging power factor may have a small accumulated reactive power reading, even though at different 

times the actual reactive power flow was large. This would happen if the negative VARs accumulated during 

the periods of leading power factor mostly cancelled the positive VARs during the periods of lagging power 

factor.  

Typical Settings and Suggested Uses  

There are no settings for the Energy Usage report. This report can be used to measure energy consumption of a 

monitored load or accumulated reactive power in power factor studies. A revenue meter that doesn't total 

negative power, or doesn't include the effects of harmonics, may show readings that differ from this report.   

Significant Change Records  

The Significant Change record type tracks quick fluctuations in the line voltage, with single cycle response, 

while ignoring gradual changes. Voltage events are time stamped to the second and listed in a report. If the 
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report is empty, there were no voltage events that exceeded the trigger threshold. This is a quick way to gauge 

the voltage power quality, because only voltage fluctuations exceeding the threshold are listed.  

Trigger Logic  

The Significant Change record type uses a voltage threshold parameter. At the end of each second during the 

recording session, the largest and smallest RMS voltages for that second are compared with the "standard" 

Significant Change voltage. This standard voltage starts as the nominal voltage picked by the Recorder during 

the two-minute countdown (typically 120, 208, 240, 277, or 480 volts). If the difference between the standard 

voltage and either the maximum or minimum voltage was more than the threshold, a Significant Change is 

recorded. In addition, the voltage (either the max or min) that caused the trigger becomes the new "standard" 

until the next Significant Change.  

As an example, consider a "standard" voltage of 119 volts, and a threshold of 2 volts. After 40 seconds, the 

voltage drops to 118 volts. No Significant Change is recorded because the 1 volt change is smaller than the 2 

volt threshold. After another 35 seconds the voltage increases to 120 volts.  The change is 2 volts, from 118 to 

120, but no Significant Change occurs because 120 volts is only 1 volt greater than the "standard" of 119. After 

another 23 seconds the voltage increases to 121 volts. A Significant Change is triggered because the 1 volt 

increase created a 2 volt difference between the 121 maximum voltage for that second, and the 119 volt 

standard. The standard voltage is now set to 121 volts, until the next Significant Change.  

Only one Significant Change per second can be recorded per channel. If both the single-cycle max and min 

meet the threshold in the same second, the voltage that is furthest from the standard becomes the new standard.  

What's Recorded  

When a Significant Change is triggered, the triggering voltage is recorded, along with a date and timestamp (to 

the second), and the channel number.  

Significant Change is recorded separately for each voltage channel (although they share the same voltage 

threshold parameter). If Significant Change memory is filled, Significant Change recording stops. All voltage 

channels use the same Significant Change memory. The amount of memory used for Significant Change is 

different for various Recorders, but every Recorder can record hundreds, and most over one thousand records.  

On most Recorders, Significant Change is always enabled for recording. On some older Recorders, enabling 

Flicker recording disables Significant Change recording. This is true for the VP-1, and 300 volts Recorders (the 

VS-3, VS-1, VS-1M, iVS-3, iVS-1, and iVS-1M) with serial numbers below 6000.  

Typical Settings and Suggested Uses  

The default setting for the Significant Change threshold is 3 volts. This setting can be as small as 1 volt or as 

large as 8 volts. Normally, a threshold between 2 and 5 volts is appropriate, depending on the nominal voltage.  

A single-cycle disturbance such as a sag will trigger Significant Change if the sag is greater than the threshold.  

If this happens, the sag voltage becomes the standard, which will trigger another Significant Change if the 

voltage returns its previous level.  

The Significant Change report is very useful for determining how often, and to what degree the line voltage is 

fluctuating. If there are no Significant Change records, then there were no fluctuations greater than the 

threshold. A Significant Change record can be correlated with the Interval record by using its timestamp. Find 

the same time period in the Interval record to see what the voltage and current were before and after. This may 

give some indication of the cause of the disturbance. All Significant Change records during a recording interval 
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will be included in a single Interval record max/min/average data point.  For example, if the interval is one 

minute, and six Significant Changes occur within one minute, they may all fall into the same Interval record 

data point. (Of course, they are still reported individually in the Significant Change report). The Significant 

Change report provides more detail than the Interval record for these disturbances.  

A key advantage of the Significant Change report is that only one disturbance per channel can be triggered each 

second.  If multiple disturbances occur during a second, the worst one is recorded. This limits the size of the 

report, making it much easier to analyze, while still giving a single-cycle response. If detailed disturbance 

information on a cycle basis is required, use the Event Change report.  Event Change gives much more detail 

but is more complicated to examine. The timestamp of a Significant Change event can be used to find the same 

disturbance in the Event Change report for further analysis.  

For even more detail, Waveform Capture can be used (if available). If the disturbance triggered Waveform 

Capture, the raw waveforms of each voltage and current channel can be displayed. Again, the Significant 

timestamp is used to find the waveform in the list of captured waveforms.  

Event Change Records  

The Event Change report provides detailed cycle-level information about each voltage disturbance. This is the 

most detailed report available short of actually looking at raw waveforms with Waveform Capture. An event is 

triggered when the voltage moves past any of a series of trip points. Max and min voltages and currents during 

the event, the event duration (in cycles), and the current before and after the event are all recorded.  

Trigger Logic  

Event Change triggering involves three parameters. The first, the Nominal voltage, sets a baseline voltage level.  

This is not the same nominal voltage selected by the Abnormal Voltage record type during the two-minute 

countdown. The Event Change Nominal voltage is specified by the user and is not picked by the Recorder. The 

second parameter is the Threshold, in volts. The Threshold is added and subtracted to the Nominal to form 

voltage trip points. These trip points are created all the way down to zero volts and up to the maximum 

Recorder voltage by using multiples of the Threshold. For example, a Nominal of 120 and a Threshold of 6 

would create trip points at 120 ± 6 = 114, 126; 120 ± 2 x 6 = 108, 132; 120 ± 3 x 6 = 102, 138; etc.  

The voltage region around the Nominal, but before any trip points (115 to 125 volts in the above example) is the 

Nominal Band. If the voltage moves from the Nominal Band to cross a trip point, an Event Change is triggered.  

This Event Change continues until the voltage either returns back into the Nominal Band or moves past another 

trip point. Each time the voltage moves past another trip point, the existing Event Change ends and a new Event 

Change is triggered. The trip points can be visualized as a grid (every 6 volts in the above example) from zero 

volts to the maximum Recorder voltage, and any time the line voltage crosses a grid line, an Event Change is 

triggered.  

There is one exception to the previous paragraph. The third setting, Holdoff Time, specifies in cycles how long 

to wait before allowing a new Event Change, if the voltage continues moving in the same direction. This setting 

is to prevent a slow sag from generating multiple Event Changes. For example, consider a Nominal of 120, a 

Threshold of 6, and a Holdoff Time of 10 cycles. The line voltage is 119 volts, and no Event Change has been 

triggered. Now a slow sag occurs. The voltage drops to 114 volts, triggering an Event Change. The next cycle, 

the voltage keeps dropping to 110 volts. On the third cycle, the voltage drops to 105 volts. This would normally 

cause the Event Change to end and a new one to be triggered, since the voltage crossed another trip point.  

However, with the Holdoff Time set to 10 cycles, no new Event Changes can be triggered for 10 cycles, as long 

as the voltage continues to drop. If the voltage changed direction and started to rise, then the Holdoff Time 

would not apply -- if the voltage rose past a trip point, the existing Event Change would end and a new one 
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would start. The Holdoff Time doesn't prevent Event Change from capturing short events, but keeps a slow 

voltage change from generating multiple events.  

Event Change can be triggered by any voltage channel. The triggering logic (and settings) is separate for each 

channel. Another channel may trigger its own Event Change while other channels have running Events, 

resulting in overlapping Events.  

What's Recorded  

When an Event Change is triggered, the trigger time is recorded, with one cycle resolution. The RMS current 

one cycle before the trigger is recorded. The direction of the voltage change, or slope, is also recorded. This is 

displayed in ProVision® as a minus for a sag and a plus for a swell. While the event is occurring, the Recorder 

keeps track of the max and min current and voltage values. When the event ends, the max and min RMS voltage 

and currents are recorded, along with the duration (in cycles). One cycle later, the RMS currents are measured 

to record the currents after the event.  

All voltage and current measurements are recorded for every channel, regardless of which channel triggered the 

event. If a sag occurs on three phases simultaneously, three Events will be triggered at the same time. These 

Events are recorded separately, even though they may have the same data in them.  

Typical Settings and Suggested Uses  

The Nominal voltage should be set as close as possible to the actual nominal line voltage. If a circuit normally 

runs at about 117 volts, use 117 as the Nominal, not 120.  Event Change is not for steady-state line voltage 

regulation problems (like the Abnormal Voltage report), but for quick sags and swells. The Threshold should be 

set small enough to catch problem events, but large enough to avoid filling up memory with unimportant data.  

A good start is 5% of the Nominal. The Nominal and Threshold can be set separately for each channel. These 

should be set accordingly if some channels see different voltage levels (for example, in a single-phase setting 

where two channels are connected line to ground, and the third channel line to line.) To effectively disable 

Event Change on a channel, set its Threshold to something huge, like 500 volts.  

The Holdoff Time is not as critical. Ideally, this is set to just larger than the slowest anticipated sag time. For 

example, if no sags (such as from motor starts, etc.) will take longer than 6 cycles for the voltage to drop to the 

sag value, the best Holdoff Time is 7 cycles. This will prevent multiple Events Changes from the same voltage 

sag. Otherwise, as the voltage dropped lower and lower, past voltage trip points, Events would continue to be 

triggered. Ideally, only one Event is triggered for a single sag or swell. A typical value is 10 cycles. This is 

longer than most sags take to reach the final sag voltage.  

Event Change provides cycle-level detail on sags and swells. A sag which merely shows up as a single point on 

the Interval record can be analyzed in the Event Change report. Usually, Event Change is not the first report to 

analyze in a recording, due to its complexity. Check the voltage Interval record for min or max voltages out of 

tolerance, or the Significant Change report for voltage fluctuations. If a disturbance needs further study, use the 

timestamp to find the fluctuation in the Event Change report. Here detailed information such as cycle duration, 

pre- and post-event RMS currents, etc. is available.  

The most useful values are the duration and max and min voltages. This information shows how long the event 

lasted, and how low or high the voltage went. The cycle timestamp can be useful to determine how far apart 

several events were which occurred in the same second. The timestamp is also used to correlate an Event 

Change with other reports, such as Significant Change and Waveform Capture.  



ProVision® User Manual       113  

The pre- and post- RMS current can be used to determine whether the load being monitored caused a sag.  

Consider a sag that triggers an Event Change. If the current one cycle before the event is low, but the max 

current during the event is high, and the current one cycle after is high (or at least higher than the pre-trigger 

current), the monitored load probably caused the event.  In-rush current from a motor start will cause this type 

of pattern: the high in-rush current pulls the voltage down, triggering an event. When the in-rush current peak is 

over, the voltage goes back up, ending the event. The final current is lower than the in-rush current, but higher 

than the current before the event.  

Another possibility is a voltage sag where the current during the event is lower than the pre trigger current (or 

about the same), and the post-trigger current is about the same. Here, the monitored load probably did not cause 

the event. Some other load pulled the voltage down, and the monitored load current dropped proportionately 

with the lowered voltage. When the voltage came back up, the current rose to its normal level also.  

ProVision® groups closely occurring Event Change records into super-events. A super-event is started when an 

Event starts on any channel. The super-event lasts until there are no running Events on all channels for at least 

an entire second. A complicated voltage disturbance may trigger several closely spaced or back-to-back Event 

Changes but will be grouped into a single super-event for easier analysis.  

Event Change is recorded separately for each voltage channel. If Event Change memory is filled, Event Change 

recording stops. All voltage channels use the same Event Change memory. The amount of memory used for 

Event Change is different for various Recorders, but every Recorder with Event Change can record hundreds, 

and most over one thousand records.  

Power Outage Records  

The Power Outage report lists the date and time of all outages during the recording session. An outage is 

defined by the Recorder to be a voltage sag below 80 volts, lasting for at least 1/3 of a second. Only channel 

one's voltage is used to trigger an outage. The beginning and end of the outage are timestamped. In the report, 

the duration is also given, along with the total number of outages and the total outage time.  

If the Recorder has battery ride-through capability, it will continue to record Histograms,  

Interval records, etc. during the outage. If there is no battery, or if the battery runs down, the Recorder loses 

power and stops recording. When power is restored, the Recorder records the end of that power outage and 

resumes recording normally.  

A power outage often triggers Waveform Capture, which may help reveal the cause of the outage.  

Flicker Records  

The Flicker record type is designed to show voltage variations that cause lights to flicker. The Recorder defaults 

to the threshold of irritation curve from IEEE Standard 141. This curve is designed to show only voltage flicker 

that is perceived as irritating. When this occurs, a flicker event is recorded with the time and magnitude.  

Trigger Logic  

A Flicker curve is specified by a list of allowable voltage thresholds, and a limit on their quantity in certain time 

spans. The default curve allows 5 voltage fluctuations of 1% or greater, in a ten second period; 10 fluctuations 

of 1.5% or greater, in a one minute period, and so on up to 10 fluctuations of 6% or greater, in a 24 hour period.  

In general, the larger the voltage variation, the less often it is allowed before triggering a Flicker record. There 

are nine pre-set time periods used, from 10 seconds to 24 hours. Each has an adjustable threshold percentage 
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and event limit. If the voltage variations exceed the threshold percentage more than the number of times 

allowed by the limit, in a certain time period, then a Flicker record is triggered.  

For example, with the default settings, if the voltage varies more than 1% over 5 times in a ten second period, a 

Flicker record is generated. These variations also count for the longer Flicker time spans if they are large 

enough.  

Flicker is computed once per second, based on the previous second's one-cycle max, min, and one second 

average RMS voltage levels. The thresholds are given as a percentage. If the max, min or average differs from 

each other by more than the percentage for a certain time period, then a flicker event counter is incremented. If 

the counter value exceeds the limit for a certain time period, a Flicker record is triggered.  

Flicker is triggered separately for each voltage channel.  

What's Recorded  

When a Flicker record is created, the date and time are recorded, along with the number of voltage events that 

exceeded the tolerance. The time span over which the flicker occurred is also recorded. Each channel is reported 

separately.  

Typical Settings and Suggested Uses  

The Flicker report is designed to show whether utility customers will perceive voltage variations as flickering 

lights. The default curve is programmed to generate Flicker events when a person would become irritated by the 

level of Flicker. The IEEE also has a curve which shows when a person would just perceive flickering lights, 

but not become irritated. The validity of these curves depends on individual circumstances such as lighting (the 

curves assume 120V incandescent) and customer sensitivity.  

The Flicker report is used both to confirm a customer complaint about flickering lights, and to measure progress 

in mitigating a problem. If no Flicker events were recorded, then no voltage variations occurred which exceeded 

the allowed limits, and the problem may have been solved. Since flickering light perception is so subjective, 

merely showing a customer a Flicker report, which shows no flicker according to a standard curve may lessen 

the complaint by showing that the voltage variations are within standard limits.  

Flicker is recorded separately for each voltage channel.  If Flicker memory is filled, Flicker recording stops. All 

voltage channels use the same Flicker memory. The amount of memory used for Flicker is different for various 

Recorders, but every Recorder with Flicker can record hundreds, and most over one thousand records.  

It is important to connect any unused voltage clip leads together, or in parallel with another voltage channel, to 

avoid generating bogus Flicker records. The threshold parameter is a percent change value, and applying a small 

percentage to an already small voltage creates tiny thresholds that are constantly exceeded. Flicker is not 

meaningful on neutral to ground voltage channels: only channels that are used to power lighting generate 

meaningful Flicker data.  

On most Recorders, Flicker is always enabled for recording. On some older Recorders, enabling Significant 

Change recording disables Flicker recording. This is true for the VP-1, and 300 volts Recorders (the VS-3, VS-

1, VS-1M, iVS-3, iVS-1, and iVS-1M) with serial numbers below 6000.  
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Abnormal Voltage Records  

The Abnormal Voltage record type shows if the average line voltage moved past a low or high threshold from 

the nominal voltage. On some Recorders, the low threshold exceedance is indicated by a green LED on the front 

panel, and the high threshold exceedance by a red LED.   

When the trigger occurs, the event is time stamped to the nearest second. There is a separate LED and report for 

each voltage channel.  

Trigger Logic  

The triggering logic uses a low and high threshold, a nominal voltage, and a trigger duration. The thresholds are 

added and subtracted to the nominal voltage to find triggering points. If the voltage crosses a triggering point 

for longer than the trigger duration, an Abnormal Voltage event occurs.  

The Recorder is initialized with a list of potential nominal voltages (such as 120, 240, etc.), with low and high 

voltage thresholds for each. The actual nominal is picked by the Recorder during the two-minute countdown.  

The average voltage during the countdown is compared to each of the nominals; the closest one becomes the 

nominal voltage for the entire recording session. There are five standard nominals in the software setup (120, 

208, 240, 277, and 480 volts), and two custom nominals.  The custom nominals can be set to any voltage. It is 

possible to enable and disable the standard and custom nominals. For example, if it’s desired to force the 

Recorder to use 230 volts as the nominal, the standard nominals should be disabled, and both custom nominals 

set to 230.  If the standard nominals were not disabled, there would be a chance for the Recorder to pick 240 

volts during the two-minute countdown, if the line voltage happened to be running closer to 240 than 230 at that 

time. The nominal is chosen by the Recorder separately for each voltage channel.  

There are separate high and low thresholds for each of the seven nominal voltages. The applicable thresholds 

are used once a nominal is selected by the Recorder after the two minute countdown. Voltage channels are 

handled separately; there is a complete set of nominals and thresholds for each. This is useful for situations such 

as a hot-leg delta, where one voltage channel is at a different voltage, or in a single phase setup where two 

channels are connected line-to-neutral, and one channel is line-to-line. The Recorder will automatically select 

the correct nominal and thresholds for the different line voltages on each channel.  

The last Abnormal Voltage parameter is a trigger duration, in seconds. This specifies how many seconds in a 

row the voltage must exceed the threshold before the Abnormal Voltage record is triggered.  

At the end of each second during the recording session, the Recorder compares the one-second average voltage 

with the nominal and the low and high thresholds. Each threshold actually creates two trip points, one above the 

nominal and one below.  For example, consider a setup where the nominal is 120 volts, the low threshold is 6, 

and the high 12. The low trip points become 120 ± 6, or 114 and 126 volts.  The high trip points are 120 ± 12, or 

108 and 132 volts.  If the one-second average voltage rises above 126 or falls below 114 volts for longer than 

the trigger duration, the low Abnormal Voltage trigger occurs. This event is timestamped, and the green LED is 

lit (if present). If the voltage goes past either high trigger point (108 or 132 volts)  

for longer than the trigger duration, the high Abnormal Voltage trigger fires. This is timestamped, and the red 

LED is lit (if present). It is possible for the low and high triggers to fire at the same time.  

The use of one-second average voltages eliminates false triggering due to momentary sags and swells.  

Abnormal Voltage is designed to trigger for average line voltage exceptions, not sub second events.  



ProVision® User Manual       116  

Once an LED indicator is lit due to an Abnormal Voltage trigger, it stays on for the rest of the recording 

session, even if the voltage returns to the nominal. The LED indication of an Abnormal voltage trigger can be 

disabled through the software. The event is still recorded normally, but no LEDs are lit.  

What's Recorded  

When Abnormal Voltage is triggered, the date and time, along with the channel and triggering voltage are 

recorded. There is a separate listing for each voltage channel, as well as low and high thresholds. Only the first 

trigger for each threshold is recorded.  

Typical Settings and Suggested Uses  

The Abnormal Voltage report is used to determine whether the voltage drifted outside the thresholds during the 

recording session. Since the LED indicators stay lit after a trigger, they can be used to see at a glance whether a 

Recorder needs to be downloaded due to line voltage problems. Usually the Abnormal Voltage report is used to 

get a quick read of whether there was any line voltage drift -- if so, then other record types such as the Interval 

record and Significant Change are used for more information.  

The default threshold settings are at 5% and 10% of the nominal voltage (for example, 6 and 12 volts for the 

120 volt nominal). The high threshold must be larger than the low threshold. The two custom nominals are 

preset at 106 and 230 volts but should be changed if a different nominal is in use. The default trigger duration is 

five seconds, and can be set as small as one second, or as large as 255 seconds.  

Loose Neutral Records  

The Loose Neutral report shows whether the typical symptoms of a loose neutral have occurred. This report is 

intended for single phase services, with voltage channels one and two connected from line to neutral. Only a 

two-channel Recorder, or a Recorder set to use two channels, can record a Loose Neutral. The symptom of a 

loose neutral condition is for one voltage leg to rise in voltage, and the other to fall, with the sum of the two 

voltages remaining close to twice the nominal voltage. For example, if the voltages start at 119 and 121 volts, 

then move to 105 and 135 volts, a loose neutral is a likely cause: one leg went up, one went down, and the sum 

is close to twice the nominal (240 volts).  

This happens when the load is not balanced, and the neutral is disconnected. If this condition is met for long 

enough, the Loose Neutral report is triggered.  

Trigger Logic  

The Loose Neutral logic uses three parameters: duration, range, and difference. These parameters are used to 

judge whether one voltage leg has risen, and one fallen, while the sum remained the same. The difference is a 

voltage that specifies the minimum difference between the two legs. For example, if the difference is 16 volts, 

then there must be at least a 16 volt separation between the two legs. The range is a voltage that specifies how 

close the sum of the two voltages must be to twice the nominal. For example, a range of 12 volts means that the 

sum of the two legs must be within 12 volts of twice the nominal voltage. Both the range and the difference 

conditions must be met for at least the number of seconds specified by the duration. If the duration is set to 5 

seconds, then the difference and range conditions must be met for 5 consecutive seconds before a loose neutral 

is declared.  One-second average voltages are used. The nominal voltage is the nominal determined during the 

two-minute countdown by the Abnormal Voltage record type, and is typically 120 volts in a single-phase 

hookup.  
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As an example, assume the difference parameter is 16 volts, and the range 12 volts, with a duration of 5 

seconds. The two-line voltages are 119 and 121 volts. Then one leg moves to 128 volts, and the other to 110 

volts. The difference between the two legs is 18 volts, which meets the difference threshold. The sum of the two 

voltages is 238 volts, which is within the required 12 volts (specified by the range value) of twice the nominal 

(240 volts). If these voltages persist for 5 seconds in a row, then a Loose Neutral record will be triggered.  

If one voltage leg changes due to heavy loading, the range parameter keeps the loose neutral from false 

triggering.  For example, if the voltages start at 119 and 121 volts, then a heavy load to channel 1 causes it to 

drop to 105 volts, with the other leg still at 121, the difference condition is met (121 - 105 > 12), but the range 

condition is not met: 105 + 121 = 226, and 226 volts is not within 12 volts of the 240 volt nominal.  

What's Recorded  

The date and time of the loose neutral triggering is recorded, along with the voltage on the two channels. Only 

the first occurrence of a Loose Neutral is recorded; if the conditions are met again, nothing further happens.  

The Loose Neutral report shows whether the neutral may have a bad connection, not the exact times the 

connection was made and broken.  

Typical Settings and Suggested Uses  

The Loose Neutral Report can show the symptoms of an actual loose neutral connection. It is worth 

investigating if the report is triggered.  However, it is possible for the Loose Neutral logic to be fooled. If both 

legs are equally loaded, then the two voltages will remain the same even if the neutral is removed. This will 

prevent the Loose Neutral trigger from firing.  It is also possible for one leg to rise and one to fall due to grossly 

different loading, and not from an actual loose connection. Thus, it is possible for a Loose Neutral to trigger 

falsely, when there is no loose connection.  

Waveform Capture Records  

Waveform Capture provides the most detailed report possible: the raw voltage and current waveforms 

themselves are recorded. With clues provided by the waveform shapes, it is sometimes possible to determine the 

cause of a voltage disturbance.  Events such as capacitors opening and closing, reclosers operating, and 

lightning strikes can sometimes produce distinctive shapes. The voltage waveforms also reveal the exact 

duration and magnitude of an event, and how much was coupled across phases. Waveform Capture is also 

useful during steady-state conditions. The current wave shapes can show harmonic currents from non-linear 

loads, and the voltage wave shapes show the distortion due to harmonic currents and transformer loading.  It 

takes a huge amount of memory to store raw waveforms. The memory size of a single 3-cycle Waveform 

Capture record is larger than the size of four hours of Interval data (at one-minute intervals).  

Trigger Logic  

Waveform Capture uses a single threshold for triggering. This threshold is a percentage. At the end of each 

60Hz cycle, the RMS voltage for that cycle is compared with the RMS voltage of the previous cycle. If the 

percent change in RMS value is greater than the threshold, Waveform Capture is triggered. Any voltage channel 

can trigger waveform capture. The voltage must be at least 5 volts to trigger.  If a trigger occurs, the waveform 

data is recorded. The trigger test is repeated every cycle, so if the RMS voltage keeps changing, Waveform 

Capture will continue to be triggered, until the voltage stabilizes.  

Waveform Capture can be triggered manually from the front panel of the Recorder. This produces a three cycle 

Capture.  
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If a Waveform Capture trigger doesn't occur at all during a recording session, a one cycle Capture is still 

recorded. This waveform is taken at the very end of the session.  

What's Recorded  

When a trigger occurs, the waveform data for the triggering cycle is recorded, along with the date and time (to 

the nearest cycle).  The waveform data for the previous cycle is also recorded, to provide a pre-trigger 

waveform. All voltage and current wave shapes are recorded, regardless of which channel caused the trigger.  

The waveforms of the next cycle are also recorded, to provide a post-trigger waveform. This creates a three 

cycle Waveform Capture record. If the trigger condition is met again on the next cycle, then an additional cycle 

of waveforms is added.  In general, the Waveform Capture record continues until one cycle after the triggering 

stops. If the voltage is fluctuating wildly, the entire Waveform Capture memory could be filled by a very long 

Waveform Capture record. If the Waveform Capture memory is full before the end of the event, the Recorder 

erases cycles of the earliest record to make room for the new data.  

The waveform data is presented as a graph and a report. The report is usually used only if the data will be 

exported to a spreadsheet.  

Typical Settings and Suggested Uses  

leads still attached. The Recorder will detect the cable and stop recording cleanly. Otherwise, the front panel menus should be 

used to bring up the "STOP" option.  Selecting this option stops the recording session cleanly. The voltage leads can then be 

removed.  

The default setting is 2%. With this threshold, the RMS voltage has to change by at least 2% in a single cycle.  

If the threshold is too tight, Waveform Capture will trigger so often that useless events overwrite the important 

waveforms. A Waveform Capture report consisting of just one very long record is an indication that the setting 

is too small. A report where all the waveform records occurred during the last few minutes of the recording 

session is another indicator of too small a threshold. In both these cases, the trigger was being met too often. Of 

course, if no waveform records are present, either the threshold was too large, or the voltage quality was too 

good. The optimal setting varies from system to system.  

The exact nature of a voltage disturbance can be seen in the Waveform Capture report. The peak voltage, length 

of the sag or swell, and the coupling from phase to phase are easily seen in the graph.  Sometimes there are 

clues regarding the cause of a voltage disturbance. A voltage sag that starts in the middle of a cycle but ends at a 

zero-crossing can be produced by a gas arrestor. The arc continues until the voltage reaches zero, then the arc is 

extinguished. A recloser operation usually begins and ends at random points in the cycle. A voltage sag that is 

preceded by an increase in current, but followed by a decrease in current, is usually caused by the monitored 

load. If the current went down during the sag, and was steady before and after, the sag was probably not caused 

by the monitored load.  

Each triggered event is often captured by the Significant Change and Event Change reports. The min or max 

voltage is usually in the Interval record as well.  These reports can be used to place the Waveform Capture 

record into the proper overall context. Use the timestamps for each record type to correlate the different reports.  

A manual trigger captures the voltage and current waveforms during steady-state conditions (unless the user 

happened to press the button at the exact moment of a disturbance).   

Transformer saturation often shows in a flattened voltage wave shape. If the positive voltage half-cycle is a 

different shape than the negative half-cycle, even-order voltage harmonics are present. Often the current 

waveforms will not be sinusoidal. The less they look like a sine wave, the higher the level of current harmonics. 

Frequently, the neutral current looks much less sinusoidal than the line currents, due to the fact that some 
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harmonics don't cancel out in a three-phase system, even with a balanced load. The more the current waveform 

is shifted from the voltage waveform, the worse the power factor.  

It is important to provide a clean ending to a recording session when using Waveform Capture. If the Recorder 

is still recording while the voltage leads are disconnected from the line, several Waveform Capture records will 

be recorded as the voltage drops to zero on each channel  These useless records of the voltage leads being 

disconnected can overwrite the valuable recorded data. If the Recorder will be downloaded in the field, a serial 

cable can be connected with the voltage  
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ProVision® Shortcut Keys 
t  Toggle the Point Table ON or OFF. Move your mouse to a peak on the graph, your cursor will turn into a 

finger, left-click mouse to set the reference line. With the Point Table ON you can: Use arrow keys (or page 

up/down) to move the ‘Point’ to the previous or next point. 

Zooming: Zoom in on any graph. Left click mouse and hold, then drag mouse over the area to zoom in on.  

 Release the left button to zoom into the window you made. Supports multiple zooms by using arrow keys to  

move the zoomed window Left or Right, through the interval data.  

u  Undo one zoom level 

z  Undo all zoom levels 

 
Control Key Shortcuts 

Ctrl+O: Open file  Ctrl+Shift+U: Full screen  

Ctrl+X: Cut   Ctrl+Shift+F: Find in files  

Ctrl+S: Save file  Ctrl+Shift+B: Display or hide the shortcut bar 

Ctrl+V: Paste   F1: Help  

Ctrl+P: Print   Ctrl+Z: Undo  

Ctrl+C: Copy   Ctrl+Y: Redo 

 

Shortcuts for the Waveform Capture Only 

3 Toggle between 3-phase and individual phase views 

   I Toggle between Line-to-neutral voltages and Line-to-line Voltages  

         Only if recorded as a WYE 

L Select a different waveform 

f Toggle fundamental harmonic 

Page Up: Move to Previous Waveform Capture 

Page Down: Move to next Waveform Capture
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Eagle and Revolution Hookup Diagram  

 
ViP, iVS-3, & iVS-3/600P Hookup Diagram  
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Additional Resources  
 

Technical Support 

Help is always available if one needs additional assistance. The technical support team at PMI is widely 

considered to be the best in the industry. Use one of the following methods to obtain technical support. 

 

Email Support 

Send email to: techsupport@powermonitors.com. 

 

Web Support 

Submit a support request via the web at https://powermonitors.com/support 

 

Telephone Support 

Contact us 24 hours a day, 7 days a week for live tech support by calling: 

(800) 296-4120 

Faxes should be sent to: (540) 432-9430 

 

Postal Mail Support 

All correspondence by post should be addressed to:  

Power Monitors, Inc. 

800 North Main Street 

Mount Crawford, VA 22841 

USA  

 

  

https://powermonitors.com/support
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Glossary of Terms  
Activate  

To make a data file active. (An active data file will have a checkmark next to its name in the Explorer.)  

Active  

The state in which a data file may be used to perform user actions, e.g. creating graphs and reports.  

Data File  

A file containing recorder data.  

Graph Template  

A blank form in which graphical data can be inserted to create a custom graph. Templates are kept in the 

Graphs and Reports folder.  

Plot  

A portion of a graph containing a single group of traces, e.g. voltage and current for channel 1.  

PQ  

power quality  

 

Ready Mode   

An operational mode in which a PMI recorder actively records PQ data and can display real-time graphical 

data.  

Recording Interval  

The amount of time between data points, e.g. a 'one minute interval' means that the recorder will record a data 

point every minute.  

Recording Session  

A period of time during which power quality data is gathered.  
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Report Template  

A blank form in which reports, and graphs can be inserted to create a custom report. Templates are kept in the 

Graphs and Reports folder.  

RTF  

Rich-Text Format  

Standby Mode  

An operational mode in which a PMI recorder may be configured for recording PQ data.  

Trace  

A line drawn on a graph representing a series of data points.  
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